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Safety warning notice
 WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do notplace the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flatsurface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact theskin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the ACadapter comply with the user-accessible surface temperature limits defined by the InternationalStandard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description
 Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 Product Name HP ProBook 6475b Notebook PCcomputer model
 √
 HP ProBook 6470b Notebook PCcomputer model
 √
 Processors ● AMD® A10-4600M 3.20-GHz/2.30-GHz processor (4.0-MB L2 cache,1600-MHz DDR3, quad core, 35 W)
 ● AMD A8-4500M 2.80-GHz/1.90-GHzprocessor (4.0-MB L2 cache, 1600-MHz DDR3, quad core, 35 W)
 ● AMD A6-4400M 3.20-GHz/2.70-GHzprocessor (1.0-MB L2 cache, 1600-MHz DDR3, dual core, 35 W)
 ● AMD A4-4300M 3.00-GHz/2.50-GHzprocessor (1.0-MB L2 cache, 1600-MHz DDR3, dual core, 35 W)
 √
 1
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Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 ● Intel® Quad Core® i7-3820QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 8.0-MBL3 cache, 45 W)
 ● Intel Quad Core i7-3720QM 2.60-GHz processor (SC turbo up to 3.60-GHz; 1600- MHz FSB, 6.0-MBL3 cache, 45 W)
 ● Intel Quad Core i7-3610QM 2.30-GHz processor (SC turbo up to 3.30-GHz; 1600- MHz FSB, 6.0-MBL3 cache, 45 W)
 ● Intel Dual Core i7-3520M 2.90-GHzprocessor (SC turbo up to 3.60-GHz;1600-MHz FSB, 4.0-MB L3 cache,35 W)
 ● Intel Dual Core i5-3360M 2.80-GHzprocessor (SC turbo up to 3.50-GHz;1600-MHz FSB, 3.0-MB L3 cache,35 W)
 ● Intel Dual Core i5-3320M 2.60-GHzprocessor (SC turbo up to 3.30-GHz;1600-MHz FSB, 3.0-MB L3 cache,35 W)
 ● Intel Dual Core i5-3210M 2.50-GHzprocessor (SC turbo up to 3.10-GHz;1600-MHz FSB, 3.0-MB L3 cache,35 W)
 ● Intel Core i3-3110M 2.40-GHzprocessor (1600-MHz FSB, 3.0-MBL3 cache, 35 W)
 ● Intel Core i3-2370M 2.40-GHzprocessor (1333-MHz FSB, 3.0-MBL3 cache, 35 W)
 ● Intel Celeron® B840 1.90-GHzprocessor (1333-MHz FSB, 2.0-MBL3 cache, 35 W)
 √
 Chipset AMD A70M fusion controller hub (FCH) √
 Mobile Intel QM77 chipset
 Mobile Intel HM76 chipset
 √
 2 Chapter 1 Product description
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Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 Graphics AMD integrated universal memoryarchitecture (UMA) graphics
 Support for DisplayPort 1.2
 Support for dual-display ports throughthe dock
 √
 ● Radeon® HD 7660G graphics oncomputer models equipped with anAMD A10-4600M 3.20-GHz/2.30-GHz processor
 ● Radeon HD 7640G graphics oncomputer models equipped with anAMD A8-4500M 2.80-GHz/1.90-GHz processor
 ● Radeon HD 7520G graphics oncomputer models equipped with anAMD A6-4400M 3.20-GHz/2.70-GHz processor
 ● Radeon HD 7420G graphics oncomputer models equipped with anAMD A4-4300M 3.00-GHz/2.50-GHz processor
 √
 Switchable discrete graphics: AMDRadeon™ HD 7570M (64-bit), with 1024-MB GDDR5 (64-MB × 32,1.5V, 5-GBPS,qty 4)
 Internal graphics: UMA with sharedvideo memory
 ● Intel HD Graphics 4000 on computermodels equipped with an Intel Core i7,i5, Intel Core i3-3110M processor
 ● Intel HD Graphics 3000 on computermodels equipped with an Intel Corei3-2370M processor
 ● Intel HD Graphics on computer modelsequipped with an Intel CeleronB840 processor
 √
 3
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Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 ● Support for dual-display ports throughdocking station
 ● Support for DisplayPort 1.2 (only oncomputer models equipped with agraphics subsystem withdiscrete memory)
 ● Support for up to 4 displays throughthe APR (only on computer modelsequipped with a graphics subsystemwith discrete memory)
 √
 Panel ● 14.0-in light-emitting diode (LED), high-definition+ (HD+), AntiGlare (AG), SVA(1600×900) display with and withoutwebcam and microphone
 ● 14.0-in LED, HD, AG, SVA(1366×768) display with and withoutwebcam and microphone
 All display assemblies include two wirelesslocal area network (WLAN) antenna cablesand two wireless wide area network(WWAN) antenna cables
 Supports low voltage differentialsignalling (LVDS)
 Supports 16:9 aspect ratio
 Supports privacy filter
 √ √
 Memory Two customer-accessible/upgradablememory module slots
 DDR3-12800 (1600-MHz) dualchannel support
 Supports 16384-MB of system RAM in thefollowing configurations:
 ● 16384-MB (8192-MB×2)
 ● 8192-MB (8192-MB×1 or 4096×2)
 ● 6144-MB (4096-MB+2048-MB)
 ● 4096-MB (4096-MB×1 or 2048-MB×2)
 ● 2048-MB (2048×1)
 √ √
 Flash cache Intel 24-GB mSATA module (Intel SmartResponse Technology (SRT), not available oncomputer models equipped with WWANor SSD)
 √
 4 Chapter 1 Product description
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Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 Hard drive Supports 6.35-cm (2.5-in) hard drives in 9.5-mm (.37-in) and 7.0-mm (.28-in) thicknesses(all hard drives use the same bracket)
 Customer-accessible
 Serial ATA
 Supports the following hard drives:
 ● 750-GB, 7200-rpm, 9.5-mm
 ● 500-GB, 7200-rpm, 7.0-mm self-encrypting drive (SED)
 ● 500-GB, 7200-rpm, 7.0-mm
 ● 320-GB, 7200-rpm, 7.0-mm
 √ √
 Solid-state drive Solid-state drive (SSD) mounts in the samebracket as the hard drive
 Customer-accessible
 Serial ATA type II and III
 Supports the following SSDs:
 ● 256-GB SED III
 ● 180-GB III
 ● 160-GB II
 ● 128-GB III
 √
 ● 128-GB SATA III √
 Upgrade drive Customer-accessible
 Supports the following drive options:
 ● Blu-ray ROM DVD±RW SuperMultiDL Drive
 ● DVD±RW Double-Layer withSuperMulti Drive
 ● DVD-ROM Drive
 ● 500-GB, 7200-rpm, 9.5-mm
 Supports no drive option
 √ √
 5
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Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 Optical drive Fixed
 Serial ATA
 12.7-mm tray load
 Supports the following optical drives:
 ● Blu-ray ROM DVD±RW SuperMultiDL Drive
 ● DVD±RW Double-Layer withSuperMulti Drive
 ● DVD-ROM Drive
 Supports zero power optical drive
 √ √
 Audio and video Two stereo speakers √ √
 HD audio with SRS Premium Sound PRO √ √
 Integrated 720p HD webcam (supports nocamera option)
 √ √
 Integrated dual-array microphone oncomputer models equipped with a webcam
 Integrated mono microphone on computermodels not equipped with a webcam
 √ √
 Modem 56kbps v.92 MDC data/fax modem module
 Supports no modem option
 Modem module cable not included
 √ √
 Ethernet Realtek RTL8151FH-CG 10/100/1000Ethernet network interface card (NIC)
 NIC Power Down technology
 S3/S4/S5 wake on LAN
 Ethernet cable not included
 √ √
 Wireless Integrated wireless personal area network(WPAN) option by way of Bluetooth 4.0enhanced data rate (EDR) module
 Supports no WPAN option
 √ √
 6 Chapter 1 Product description

Page 15
                        

Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 Integrated wireless local area network(WLAN) options by way of wireless module
 Three WLAN antennas built intodisplay assembly
 Support for the following WLAN formats:
 ● Atheros WB225 1×1 802.11b/g/nBluetooth Combo Adapter
 ● Broadcom 43228 802.11abgn 2×2Wi-Fi Adapter
 ● Intel Centrino Advanced-N 6205WLAN module
 ● Intel Centrino Ultimate-N 6300WLAN module
 ● Intel Centrino Wireless-N 2200802.11b/g/n 2×2 WiFi Adaptor
 Supports no WLAN option
 √ √
 Integrated wireless wide area network(WWAN) options by way ofwireless module
 Two world-wide/5-band WWAN antennasbuilt into display assembly
 Secured by subscriber identity module (SIM,user-accessible behind battery)
 Support for the following WWAN formats:
 ● HP lt2523 LTE/HSPA+ MobileBroadband Module
 ● HP lt2522 LTE/EV-DO MobileBroadband Module
 ● HP un2430 EV-DO/HSPA MobileBroadband Module
 ● HP hs2350 HSPA+ MobileBroadband Module
 Supports no WWAN option
 Supports WWAN after market option
 √ √
 7
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Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 External mediacards
 Integrated 54-mm ExpressCard
 Secure Digital (SD) flash media slot withpush-push technology, supporting thefollowing digital card formats:
 ● MultiMediaCard (MMC)
 ● MMC+
 ● Secure Digital (SD) Memory Card
 ● SDHC
 ● SDXC
 √ √
 Ports ● 1394a port
 ● Audio-in (mono microphone)
 ● Audio-out (stereo headphone)
 ● Battery connector
 ● DisplayPort 1.2 (on computer modelsequipped with a graphics subsystemwith discrete memory)
 ● DisplayPort 1.1a (on computer modelsequipped with a graphics subsystemwith UMA memory)
 ● Docking connector
 ● eSATA/USB 2.0 combo port
 ● HP Smart AC adapter
 ● RJ-45 (Ethernet)
 ● RJ-11 (modem)
 ● Secondary battery connector
 ● Serial port
 ● USB 3.0 ports (2)
 ● USB 2.0 port
 ● USB 2.0 charging port
 ● VGA (Dsub 15 pin) supporting:1920×1200 external resolution @75 Hz, hot plug and unplug andautodetection for correct output to wide-aspect vs. standard aspect video
 √ √
 8 Chapter 1 Product description
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Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 Keyboard/pointingdevices
 Full-size keyboard with numeric keypad(upper-left justified), dual-point, spill-resistant,chiclet-style, with durakeys
 √ √
 Gesture support: MultiTouch gesturesenabled, two-finger scrolling, and pinch-zoom as default
 √ √
 Taps enabled by default √ √
 Support for TouchPad with image sensor √ √
 Support for Windows 8 Indirect Touch √ √
 Power requirements Supports the following HP Smart AC adapters:
 ● 90-W HP Smart AC adapter (PFC, EM,3-wire)
 √ √
 ● 90-W HP Smart AC adapter (PFC, 3-wire)
 √ √
 ● 65-W HP Smart AC adapter (non-PFC,3-wire)
 √ √
 ● 65-W HP Smart AC adapter (RC/V,EM, 3-wire)
 √ √
 Supports the following batteries:
 ● 9-cell, 100-Wh, 3.0-Ah battery
 ● 9-cell, 73-Wh, 2.2-Ah battery
 ● 6-cell, 62-Wh, 2.8-Ah battery
 ● 6-cell, 55-Wh, 2.8-Ah battery
 ● 3-cell, 31-Wh, 2.8-Ah battery
 √ √
 Security Supports security cable lock √ √
 Supports fingerprint reader and nofingerprint reader option
 √ √
 Supports Trusted Platform Module (TPM) 1.2(Infineon, soldered down) andTPM Enhanced Drive Lock (not supported inAsia and the People's Republic of China)
 √ √
 Integrated Smart Card reader (active) √ √
 Full volume encryption √ √
 Preboot authentication (password,Smart Card)
 √ √
 9
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Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 Operating system Preinstalled:
 ● Windows® 7 Home Premium 64- and32-bit with Microsoft Basics (inCanada, Japan, and the United States)
 ● Windows 7 Professional 64- and 32-bitwith Microsoft Basics (in Canada,Japan, and the United States)
 ● FreeDOS
 √ √
 Preinstalled with Microsoft Office:
 ● Windows 7 Home Basic 32-bit withOffice Starter (emerging markets only,not available in Japan)
 ● Windows 7 Home Premium 64- and32-bit with Office Starter (not availablein Japan)
 ● Windows 7 Home Premium 64-bit withOffice 2010 Personal (only in Japan)
 ● Windows 7 Home Premium 64-bit withOffice 2010 Home and Personal (onlyin Japan)
 ● Windows 7 Home Premium 64-bit withOffice 2010 Professional (onlyin Japan)
 ● Windows 7 Professional 64- and 32-bitwith Office 2010 Starter (not availablein Japan)
 ● Windows 7 Professional 64- and 32-bitwith Office 2010 Business and Home(only in Japan)
 ● Windows 7 Professional 64- and 32-bitwith Office 2010 Personal (onlyin Japan)
 ● Windows 7 Professional 64- and 32-bitwith Office 2010 Professional (onlyin Japan)
 √ √
 Restore media—DR-DVD:
 ● Windows 7
 ● Windows 7 with Windows DVD
 √ √
 10 Chapter 1 Product description
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Category Description HP ProBook 6475bNotebook PC
 computer model
 HP ProBook 6470bNotebook PC
 computer model
 Restore media—OS-DVD:
 ● Windows 7 Home Basic 32-bit
 ● Windows 7 Home Premium 64- and32-bit
 ● Windows 7 Professional 64- and 32-bit
 √ √
 Certified:
 ● Microsoft WHQL
 ● SuSE Linux 64-bit Service Pack 2
 √ √
 Web-only support:
 ● Windows XP Pro 32-bit
 ● Windows 7 Home Basic 64-bit
 ● Windows 7 Enterprise 64- and 32-bit
 ● Windows 7 Ultimate 64- and 32-bit
 √ √
 Serviceability End user replaceable parts:
 ● AC adapter
 ● Battery
 ● Hard drive
 ● Keyboard
 ● Memory module
 ● mSATA drive
 ● Optical drive
 ● Solid-state drive
 ● WLAN module
 ● WWAN module
 √ √
 11
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2 External component identification
 Display
 Item Component Description
 (1) Internal display switch Turns off the display or initiates Suspend if the display isclosed while the power is on.
 NOTE: The display switch is not visible from the outsideof the computer.
 (2) WLAN antennas (2)* Send and receive wireless signals to communicatewith WLANs.
 (3) Internal microphones (2, select models only) Record sound.
 NOTE: Only models equipped with a webcam have 2internal microphones. Models without a webcam haveonly 1 internal microphone.
 (4) Webcam light (select models only) On: The webcam is in use.
 12 Chapter 2 External component identification
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Item Component Description
 (5) Webcam (select models only) Records video and captures still photographs.
 *The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately aroundthe antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, andEnvironmental Notices that applies to your country or region.
 Display 13
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Buttons and fingerprint reader (select models only)NOTE: Your computer may look slightly different from the illustration in this section.
 Item Component Description
 (1) TouchPad on/off button Turns the TouchPad on and off.
 (2) Power button ● When the computer is off, press the button to turn onthe computer.
 ● When the computer is on, press the button briefly toinitiate Suspend.
 ● When the computer is in the Suspend state, pressthe button briefly to exit Suspend.
 ● When the computer is in Hibernation, press thebutton briefly to exit Hibernation.
 If the computer has stopped responding and operatingsystem shutdown procedures are ineffective, press andhold the power button for at least 5 seconds to turn offthe computer.
 To learn more about your power settings:
 1. Select Computer > Control Center.
 2. In the left pane, click System, and then clickPower Management in the right pane.
 (3) Wireless button Turns the wireless feature on or off but does not establisha wireless connection.
 14 Chapter 2 External component identification
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Item Component Description
 (4) Web browser button ● When the computer is on, press the button to openthe default Web browser.
 ● When the computer is off, in the Suspend state, orin Hibernation, the button does not perform anyaction or function.
 (5) Volume mute button Mutes and restores speaker sound.
 (6) Fingerprint reader (select models only) Allows a fingerprint logon instead of a password logon.
 KeysNOTE: Your computer may look slightly different from the illustration in this section.
 Item Component Description
 (1) Function keys Execute frequently used system functions when pressed incombination with the fn key.
 (2) fn key Executes frequently used system functions when pressedin combination with a function key.
 (3) Operating system logo key Displays the operating system menu.
 (4) Operating system applications key Displays a shortcut menu for items beneath the cursor.
 Keys 15
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Item Component Description
 (5) Embedded numeric keypad When the keypad is turned on, it can be used like anexternal numeric keypad.
 Each key on the keypad performs the function indicatedby the icon in the upper-right corner of the key.
 (6) num lk key Turns the embedded numeric keypad on and off whenpressed in combination with the fn key.
 LightsNOTE: Your computer may look slightly different from the illustration in this section.
 Item Component Description
 (1) TouchPad light ● Amber: The TouchPad is off.
 ● Off: The TouchPad is on.
 (2) Caps lock light ● On: Caps lock is on.
 ● Off: Caps lock is off.
 (3) Power light ● On: The computer is on.
 ● Blinking: The computer is in the Suspend state.
 ● Off: The computer is off or in Hibernation.
 (4) Wireless light ● White: An integrated wireless device, such as aWLAN device and/or a Bluetooth device, is on.
 ● Amber: All wireless devices are off.
 16 Chapter 2 External component identification
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Item Component Description
 (5) Web browser light ● On: The computer is on.
 ● Off: The computer is off, in the Suspend state, orin Hibernation.
 (6) Mute light ● Amber: Computer sound is off.
 ● Off: Computer sound is on.
 (7) Num lock light On: Num lock is on.
 TouchPadNOTE: Your computer may look slightly different from the illustration in this section.
 Item Component Description
 (1) Pointing stick (select models only) Moves the pointer and selects or activates items onthe screen.
 (2) Left pointing stick button (select modelsonly)
 Functions like the left button on an external mouse.
 (3) TouchPad on/off button Turns the TouchPad on or off.
 (4) TouchPad zone Moves the pointer and selects or activates items onthe screen.
 TouchPad 17
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Item Component Description
 (5) Left TouchPad button Functions like the left button on an external mouse.
 (6) Right pointing stick button (select modelsonly)
 Functions like the right button on an external mouse.
 (7) Right TouchPad button Functions like the right button on an external mouse.
 FrontNOTE: Your computer may look slightly different from the illustration in this section.
 Item Component Description
 (1) Display release latch Opens the computer.
 (2) Wireless light ● White: An integrated wireless device, such as aWLAN device and/or a Bluetooth device, is on.
 ● Amber: All wireless devices are off.
 (3) Power light ● On: The computer is on.
 ● Blinking: The computer is in the Suspend state.
 ● Off: The computer is off or in Hibernation.
 (4) AC adapter/Battery light ● Amber: The computer is connected to externalpower and the battery is charged from 0 to90 percent.
 ● White: The computer is connected to external powerand the battery is charged from 90 to 99 percent.
 ● Blinking amber: A battery that is the only availablepower source has reached a low battery level.When the battery reaches a critical battery level, thebattery light begins blinking rapidly.
 ● Off: The battery is fully charged.
 18 Chapter 2 External component identification
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Item Component Description
 (5) Hard drive light ● Blinking white: The hard drive or optical drive isbeing accessed.
 ● Amber: HP 3D DriveGuard has temporarily parkedthe hard drive.
 (6) Speakers (2) Produce sound. One of the speakers is on the bottom ofthe computer, and it cannot be seen from the front of thecomputer.
 Left sideNOTE: Your computer may look slightly different from the illustration in this section.
 Item Component Description
 (1) Power connector Connects an AC adapter.
 (2) 1394 port Connects an optional IEEE 1394 or 1394a device, suchas a camcorder.
 (3) USB 3.0 ports (2) Connect optional USB 3.0 devices and provideenhanced USB power performance.
 (4) HP ExpressCard slot or Smart Card reader(depending on configuration)
 Supports optional ExpressCards or Smart Cards.
 (5) Media Card Reader Supports the following digital card formats:
 ● MultiMediaCard (MMC)
 ● MMC+
 ● Secure Digital (SD) Memory Card
 ● SDHC
 ● SDXC
 Left side 19
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Item Component Description
 (6) Upgrade bay (optical drive shown) The upgrade bay can hold a weight-saver option, a harddrive, or an optical drive that reads an optical disc.
 NOTE: On select models, the optical drive also writesto an optical disc.
 (7) Optical drive eject button (select modelsonly)
 Releases the disc tray.
 Right sideNOTE: Your computer may look slightly different from the illustration in this section.
 Item Component Description
 (1) Audio-out (headphone) jack Produces sound when connected to optional poweredstereo speakers, headphones, earbuds, a headset, ortelevision audio.
 WARNING! To reduce the risk of personal injury,adjust the volume before putting on headphones,earbuds, or a headset. For additional safety information,refer to the Regulatory, Safety, andEnvironmental Notices.
 NOTE: When a device is connected to the jack,the computer speakers are disabled.
 (2) Audio-in (microphone) jack Connects an optional computer headset microphone,stereo array microphone, or monaural microphone.
 (3) eSATA/USB 2.0 port Connects an optional high-performance eSATAcomponent, such as an eSATA external hard drive, orconnects an optional USB device.
 (4) USB 2.0 port Connects an optional USB device.
 (5) DisplayPort Connects an optional digital display device, such as ahigh-performance monitor or projector.
 20 Chapter 2 External component identification
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Item Component Description
 (6) Vents (2) Enables airflow to cool internal components.
 NOTE: The computer fan starts up automatically to coolinternal components and prevent overheating. It isnormal for the internal fan to cycle on and off duringroutine operation.
 (7) Security cable slot Attaches an optional security cable to the computer.
 NOTE: The security cable is designed to act as adeterrent, but it may not prevent the computer from beingmishandled or stolen.
 RearNOTE: Your computer may look slightly different from the illustration in this section.
 Item Component Description
 (1) RJ-11 (modem) jack Connects a modem cable.
 (2) External monitor port Connects an external VGA monitor or projector.
 (3) RJ-45 (network) jack Connects a network cable.
 Rear 21
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BottomNOTE: Your computer may look slightly different from the illustration in this section.
 Item Component Description
 (1) Vents (4) Enables airflow to cool internal components.
 NOTE: The computer fan starts up automatically to coolinternal components and prevent overheating. It isnormal for the internal fan to cycle on and off duringroutine operation.
 (2) Battery release latch Releases the battery.
 (3) Docking connector Connects an optional docking device.
 (4) Service cover release latch Releases the service cover from the computer.
 (5) Battery bay Holds the battery.
 (6) Accessory battery connector Connects an optional accessory battery.
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Item Component Description
 (7) Bluetooth compartment Contains a Bluetooth device.
 (8) Service cover Provides access to the hard drive, and also contains theWLAN module slot and the memory module slots.
 CAUTION: To prevent an unresponsive system, replacethe wireless module only with a wireless moduleauthorized for use in the computer by the governmentalagency that regulates wireless devices in your country orregion. If you replace the module and then receive awarning message, remove the module to restorecomputer functionality, and then contact support.
 Bottom 23
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Service tagWhen ordering parts or requesting information, provide the computer serial number and model numberprovided on the service tag. It is necessary to remove the battery to obtain these numbers. See Batteryon page 34 for battery removal instructions.
 Item Description Function
 (1) Product name This is the product name affixed to the front ofthe computer.
 (2) Serial number (s/n) This is an alphanumeric identifier that is unique toeach product.
 (3) Part number/Product number (p/n) This number provides specific information about theproduct's hardware components. The part numberhelps a service technician to determine whatcomponents and parts are needed.
 (4) Warranty period This number describes the duration of the warrantyperiod for the computer.
 (5) Model description This is the alphanumeric identifier used to locatedocuments, drivers, and support for the computer.
 Service tag 25
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Item Component Spare part number
 (1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assemblyspare part information, see Display assembly subcomponents on page 33.
 (2) Keyboard with pointing stick (includes keyboard cable and pointing stick cable):
 For use in Belgium 684332-A41
 For use in Brazil 684332-201
 For use in Bulgaria 684332-261
 For use in Canada 684332-DB1
 For use in the Czech Republic and Slovakia 684332-A81
 For use in Denmark 684332-081
 For use in France 684332-051
 For use in Germany 684332-041
 For use in Greece 684332-DJ1
 For use in Hungary 684332-211
 For use in Iceland 684332-DD1
 For use in India 684332-D61
 For use in Israel 684332-BB1
 For use in Italy 684332-061
 For use in Japan 684332-291
 For use in Latin America 684332-161
 For use in the Netherlands 684332-B31
 For use in Norway 684332-091
 For use in Northwest Africa 684332-FP1
 For use in Portugal 684332-131
 For use in Romania 684332-271
 For use in Russia 684332-251
 For use in Saudi Arabia 684332-171
 For use in Slovenia 684332-BA1
 For use in South Korea 684332-AD1
 For use in Spain 684332-071
 For use in Sweden and Finland 684332-B71
 For use in Switzerland 684332-BG1
 For use in Taiwan 684332-AB1
 For use in Thailand 684332-281
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Item Component Spare part number
 For use in Turkey 684332-141
 For use in the United Kingdom and Singapore 684332-031
 For use in the United States 684332-001
 (2) Keyboard without pointing stick (includes keyboard cable):
 For use in Belgium 684333-A41
 For use in Brazil 684333-201
 For use in Bulgaria 684333-261
 For use in Canada 684333-DB1
 For use in the Czech Republic and Slovakia 684333-A81
 For use in Denmark 684333-081
 For use in France 684333-051
 For use in Germany 684333-041
 For use in Greece 684333-DJ1
 For use in Hungary 684333-211
 For use in Iceland 684333-DD1
 For use in India 684333-D61
 For use in Israel 684333-BB1
 For use in Italy 684333-061
 For use in Japan 684333-291
 For use in Latin America 684333-161
 For use in the Netherlands 684333-B31
 For use in Norway 684333-091
 For use in Northwest Africa 684333-FP1
 For use in Portugal 684333-131
 For use in Romania 684333-271
 For use in Russia 684333-251
 For use in Saudi Arabia 684333-171
 For use in Slovenia 684333-BA1
 For use in South Korea 684333-AD1
 For use in Spain 684333-071
 For use in Sweden and Finland 684333-B71
 For use in Switzerland 684333-BG1
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Item Component Spare part number
 For use in Taiwan 684333-AB1
 For use in Thailand 684333-281
 For use in Turkey 684333-141
 For use in the United Kingdom and Singapore 684333-031
 For use in the United States 684333-001
 (3) Top cover (includes TouchPad):
 Equipped with 2 pointing stick buttons, 2 TouchPad buttons, and a fingerprint reader 684336-001
 Equipped with 2 pointing stick buttons and a fingerprint reader 684338-001
 (4) Fan (includes cable) 641839-001
 (5) Heat sink (includes replacement thermal material):
 Heat sink for use only on HP ProBook 6475b Notebook PC computer models 658543-001
 Heat sink for use only on HP ProBook 6470b Notebook PC computer modelsequipped with a graphics subsystem with discrete memory
 686021-001
 Heat sink for use only on HP ProBook 6470b Notebook PC computer modelsequipped with a graphics subsystem with UMA memory
 693371-001
 (6) System board (includes replacement thermal material):
 For use only on HP ProBook 6475b Notebook PC computer models:
 For use on computer models equipped with WWAN capability in all countries andregions except in the People's Republic of China and the Ukraine
 684341-001
 For use on computer models not equipped with WWAN capability in all countries andregions except in the People's Republic of China and the Ukraine
 684342-001
 For use on computer models equipped with WWAN capability only in the People'sRepublic of China and the Ukraine
 690036-001
 For use on computer models not equipped with WWAN capability only in the People'sRepublic of China and the Ukraine
 690037-001
 For use only on HP ProBook 6470b Notebook PC computer models:
 For use on computer models equipped with the Intel QM77 chipset, a graphicssubsystem with discrete memory, and WWAN capability in all countries and regionsexcept in the People's Republic of China and the Ukraine
 686039-001
 For use on computer models equipped with the Intel QM77 chipset, a graphicssubsystem with UMA memory, and WWAN capability in all countries and regionsexcept in the People's Republic of China and the Ukraine
 686037-001
 For use on computer models equipped with the Intel HM76 chipset, a graphicssubsystem with discrete memory, and WWAN capability in all countries and regionsexcept in the People's Republic of China and the Ukraine
 686038-001
 For use on computer models equipped with the Intel HM76 chipset, a graphicssubsystem with UMA memory, and WWAN capability in all countries and regionsexcept in the People's Republic of China and the Ukraine
 686036-001
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Item Component Spare part number
 For use on computer models equipped with the Intel HM76 chipset, a graphicssubsystem with UMA memory, but without WWAN capability in all countries andregions except in the People's Republic of China and the Ukraine
 686035-001
 For use on computer models equipped with the Intel QM77 chipset, a graphicssubsystem with discrete memory, and WWAN capability only in the People's Republicof China and the Ukraine
 691715-001
 For use on computer models equipped with the Intel QM77 chipset, a graphicssubsystem with UMA memory, and WWAN capability only in the People's Republic ofChina and the Ukraine
 691713-001
 For use on computer models equipped with the Intel HM76 chipset, a graphicssubsystem with discrete memory, and WWAN capability only in the People's Republicof China and the Ukraine
 691714-001
 For use on computer models equipped with the Intel HM76 chipset, a graphicssubsystem with UMA memory, and WWAN capability only in the People's Republic ofChina and the Ukraine
 691712-001
 For use on computer models equipped with the Intel HM76 chipset, a graphicssubsystem with UMA memory, but without WWAN capability only in the People'sRepublic of China and the Ukraine
 691711-001
 (7) Speaker assembly (includes cable) 641840-001
 (8) Processor (includes replacement thermal material):
 For use only on HP ProBook 6475b Notebook PC computer models:
 AMD A10-4600M 3.20-GHz/2.30-GHz processor with Radeon HD 7660G graphics(4.0-MB L2 cache, 1600-MHz DDR3, quad core, 35 W)
 683046-001
 AMD A8-4500M 2.80-GHz/1.90-GHz processor with Radeon HD 7640G graphics(4.0-MB L2 cache, 1600-MHz DDR3, quad core, 35 W)
 683048-001
 AMD A6-4400M 3.20-GHz/2.70-GHz processor with Radeon HD 7520G graphics(1.0-MB L2 cache, 1600-MHz DDR3, dual core, 35 W)
 683047-001
 AMD A4-4300M 3.00-GHz/2.50-GHz processor with Radeon HD 7420G graphics(1.0-MB L2 cache, 1600-MHz DDR3, dual core, 35 W)
 685990-001
 For use only on HP ProBook 6470b Notebook PC computer models:
 Intel Quad Core i7-3820QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 8.0-MB L3 cache, 45 W)
 681284-001
 Intel Quad Core i7-3720QM 2.60-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 6.0-MB L3 cache, 45 W)
 681283-001
 Intel Quad Core i7-3610QM 2.30-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 6.0-MB L3 cache, 45 W)
 680646-001
 Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHzFSB, 4.0-MB L3 cache, 35 W)
 681954-001
 Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHzFSB, 3.0-MB L3 cache, 35 W)
 681953-001
 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHzFSB, 3.0-MB L3 cache, 35 W)
 681952-001
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Item Component Spare part number
 Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHzFSB, 3.0-MB L3 cache, 35 W)
 680645-001
 Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001
 Intel Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 677152-001
 Intel Celeron B840 1.90-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, 35 W) 664663-001
 (9) Modem module
 NOTE: The modem module cable is included in the Cable Kit, spare part number641830-001.
 628824-001
 (10) Function board 658142-001
 (11) USB board 658141-001
 (12) Base enclosure (includes rubber feet, service cover release latch assembly, and battery release latch assembly)
 For use only on computer models equipped with WWAN capability 684334-001
 For use only on computer models not equipped with WWAN capability 687224-001
 Rubber Kit (not illustrated, includes display bezel left and right rubber screw covers,base enclosure front and rear rubber screw covers, top cover rubber bumper)
 641831-001
 Latch Kit (not illustrated, includes service cover release latch assembly componentsand battery release latch assembly components)
 684339-001
 (13) Battery (Li ion):
 9-cell, 100-Wh, 3.00-Ah 631243-001
 9-cell, 100-Wh, 3.00-Ah 634087-001
 9-cell, 73-Wh, 2.20-Ah 634089-001
 6-cell, 62-Wh, 2.80-Ah 628668-001
 6-cell, 55-Wh, 2.80-Ah 628670-001
 6-cell, 51-Wh, 2.55-Ah 659083-001
 3-cell, 31-Wh, 2.80-Ah 628664-001
 (14) Bluetooth module 4.0 EDR
 NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number641830-001.
 655792-001
 (15) Memory modules (PC3-12800, 1666-MHz, DDR3):
 8-GB 670034-001
 4-GB 641369-001
 2-GB 652972-001
 (16) WLAN module:
 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter 675794-001
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Item Component Spare part number
 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter 669832-001
 Intel Centrino Advanced-N 6205 WLAN module 631954-001
 Intel Centrino Ultimate-N 6300 WLAN module 572511-001
 Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adaptor 670288-001
 (17) WWAN module:
 HP lt2523 LTE/HSPA+ Mobile Broadband Module 675793-001
 HP lt2522 LTE/EV-DO Mobile Broadband Module 675791-001
 HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001
 HP hs2350 HSPA+ Mobile Broadband Module 668969-001
 (18) RTC battery 651948-001
 (19) Optical drive (includes optical drive bezel and optical drive bracket):
 Blu-ray ROM DVD±RW SuperMulti DL Drive 684330-001
 DVD±RW Double-Layer with SuperMulti Drive 684329-001
 DVD-ROM Drive 684328-001
 (20) Hard drive (does not include hard drive bracket or screws):
 750-GB, 7200-rpm, 9.5-mm 633252-001
 500-GB, 7200-rpm, 9.5-mm self-encrypting drive 683801-001
 500-GB, 7200-rpm, 9.5-mm 634925-001
 320-GB, 7200-rpm, 9.5-mm 634862-001
 Hard Drive Hardware Kit (not illustrated, includes hard drive bracket and screws) 642774-001
 (21) Service cover 684326-001
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Display assembly subcomponents
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Item Component Spare part number
 (1) Display bezel:
 For use only on HP ProBook 6475b Notebook PC computer models 683781-001
 For use only on HP ProBook 6470b Notebook PC computer models 685999-001
 Display Hinge Cover Kit, includes: 642783-001
 (2) Display hinge covers
 (3) Display Hinge Kit (includes left and right display hinges and left and righthinge brackets)
 641836-001
 (4) Display panel:
 For use on all computer models:
 14.0-in, LED, SVA, HD+, AntiGlare display panel 684348-001
 14.0-in, LED, SVA, HD, AntiGlare display panel 684347-001
 For use only on HP ProBook 6470b Notebook PC computer models:
 14.0-in, LED, FLT, HD+, AntiGlare display panel 686047-001
 14.0-in, LED, FLT, HD, AntiGlare display panel 686046-001
 (5) Webcam/microphone module 684346-001
 Microphone module 642797-001
 Display Cable Kit, includes:
 (6) Display panel cable:
 For use only on computer models equipped with an HD+ display assembly 693064-001
 For use only on computer models equipped with an HD display assembly 693063-001
 (7) WWAN Antenna Kit (includes left and right WWAN antenna cablesand transceivers)
 642801-001
 (8) WLAN Antenna Kit (includes left and right WLAN antenna cables and transceivers) 642799-001
 (9) Display enclosure 642778-001
 Display Panel Support Kit (not illustrated, includes WLAN antenna cables andtransceivers, WWAN antenna cables and transceivers, and display enclosure)
 657836-001
 Display Rubber Kit (not illustrated, includes display bezel rubber screw covers anddisplay bezel rubber bumpers)
 642785-001
 Display Miscellaneous Kit 697439-001
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Cable Kit
 Item Component Spare part number
 Cable Kit, includes: 641830-001
 (1) Bluetooth module cable
 (2) TouchPad board cable
 (3) RJ-11 jack cable
 Cable Kit 35
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Plastics Kit
 Item Description Spare part number
 Plastics Kit, includes: 684351-001
 (1) RJ-11 jack plug
 (2) ExpressCard slot space saver
 (3) Optical drive bay space saver
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Mass storage devices
 Item Description Spare part number
 (1) Hard drive (does not include hard drive bracket or screws):
 750-GB, 7200-rpm, 9.5-mm 633252-001
 500-GB, 7200-rpm, 9.5-mm SED 683801-001
 500-GB, 7200-rpm, 9.5-mm 634925-001
 320-GB, 7200-rpm, 9.5-mm 634862-001
 Hard Drive Hardware Kit, includes: 642774-001
 (2) Hard drive bracket
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Item Description Spare part number
 Hard drive bracket screws (not illustrated)
 (3) Optical drive (includes optical drive bezel and optical drive bracket):
 Blu-ray ROM DVD±RW SuperMulti DL Drive 684330-001
 DVD±RW Double-Layer with SuperMulti Drive 684329-001
 DVD-ROM Drive 684328-001
 (4) Upgrade bay (includes bezel and bracket) 643926-001
 (5) Solid-state drive (does not include solid-state drive bracket or screws):
 128-GB SATA III solid-state drive for use only on HP ProBook 6475b Notebook PCcomputer models
 692425-001
 For use only on HP ProBook 6470b Notebook PC computer models:
 256-GB SATA III self-encrypting solid-state drive 691466-001
 180-GB SATA III solid-state drive 692097-001
 160-GB SATA II solid-state drive 693863-001
 128-GB SATA III solid-state drive 690229-001
 24-GB flash cache module (not illustrated, for use only on HP ProBook 6470bNotebook PC computer models)
 689954-001
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Miscellaneous parts
 Component Spare part number
 AC adapter:
 90-W HP Smart AC adapter (PFC, EM, 3-wire) 693713-001
 90-W HP Smart AC adapter (PFC, 3-wire) 693712-001
 65-W HP Smart AC adapter (non-PFC, 3-wire) 693711-001
 65-W HP Smart AC adapter (RC/V, EM, 3-wire) 693710-001
 Carrying case:
 HP basic carrying case 455084-001
 HP essential nylon case 612757-001
 HP professional top-load slim case 592923-001
 Lock:
 HP notebook computer combination lock 591699-001
 HP notebook computer keyed cable lock 626729-001
 Optical mouse:
 HP USB optical travel mouse 434594-001
 HP USB/PS2 2-button optical mouse 390632-001
 Power cord (3-pin, black, 1.83-m):
 For use in Argentina 490371-D01
 For use in Australia 490371-011
 For use in Brazil 490371-202
 For use in Denmark 490371-081
 For use in Europe 490371-021
 For use in India 490371-D61
 For use in Israel 490371-BB1
 For use in Japan 490371-291
 For use in North America 490371-001
 For use in the People's Republic of China 490371-AA1
 For use in South Africa 490371-AR1
 For use in South Korea 490371-AD1
 For use in Switzerland 490371-111
 For use in Taiwan 490371-AB1
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Component Spare part number
 For use in Thailand 490371-201
 For use in the United Kingdom and Singapore 490371-031
 Screw Kit 686032-001
 Sequential part number listing
 Spare part number Description
 390632-001 HP USB/PS2 2-button optical mouse
 434594-001 HP USB optical travel mouse
 455084-001 HP basic carrying case
 490371-001 Power cord for use in North America (3-pin, black, 1.83-m)
 490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)
 490371-021 Power cord for use in Europe (3-pin, black, 1.83-m)
 490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)
 490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)
 490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)
 490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)
 490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)
 490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)
 490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)
 490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)
 490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)
 490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)
 490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)
 490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)
 490371-D61 Power cord for use in India (3-pin, black, 1.83-m)
 572511-001 Intel Centrino Ultimate-N 6300 WLAN module
 591699-001 HP notebook computer combination lock
 592923-001 HP professional top load slim case
 612757-001 HP essential nylon case
 626729-001 HP notebook computer keyed cable lock
 628664-001 3-cell, 31-Wh, 2.80-Ah, Li-ion battery
 40 Chapter 3 Illustrated parts catalog

Page 49
                        

Spare part number Description
 628668-001 6-cell, 62-Wh, 2.80-Ah, Li-ion battery
 628670-001 6-cell, 55-Wh, 2.80-Ah, Li-ion battery
 628824-001 Modem module (does not include the modem module cable)
 NOTE: The modem module cable is included in the Cable Kit, spare part number 641830-001.
 631243-001 9-cell, 100-Wh, 3.0-Ah, Li-ion battery
 631954-001 Intel Centrino Advanced-N 6205 WLAN module
 633252-001 750-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)
 NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, sparepart number 642774-001.
 634087-001 9-cell, 100-Wh, 3.00-Ah, Li-ion battery
 634089-001 6-cell, 73-Wh, 2.20-Ah, Li-ion battery
 634400-001 HP un2430 EV-DO/HSPA Mobile Broadband Module
 634862-001 320-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)
 NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, sparepart number 642774-001.
 634925-001 500-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)
 NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, sparepart number 642774-001.
 641369-001 4-GB memory module (PC3, 12800, 1600-MHz)
 641830-001 Cable Kit (includes Bluetooth module cable, RJ-11 jack cable, and TouchPad cable)
 641831-001 Rubber Kit (includes display bezel left and right rubber screw covers, base enclosure front and rearrubber screw covers, top cover rubber bumper)
 641836-001 Display Hinge Kit (includes left and right display hinges and left and right hinge brackets)
 641839-001 Fan (includes cable)
 641840-001 Speaker assembly (includes cable)
 642774-001 Hard Drive Hardware Kit (includes hard drive bracket and screws)
 642778-001 Display enclosure
 642783-001 Display Hinge Cover Kit (includes left and right display hinge covers)
 642785-001 Display Rubber Kit (includes display bezel rubber screw covers and display bezel rubber bumpers)
 642797-001 Microphone module
 642799-001 WLAN Antenna Kit (includes left and right WLAN antenna cables and transceivers)
 642801-001 WWAN Antenna Kit (includes left and right WWAN antenna cables and transceivers)
 651948-001 RTC battery (includes cable and double-sided tape)
 652972-001 2-GB memory module (PC3, 12800, 1600-MHz)
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Spare part number Description
 655792-001 Bluetooth module 4.0 EDR (does not include the Bluetooth module cable)
 NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number 641830-001.
 657836-001 Display Panel Support Kit (includes display enclosure, WLAN antenna cables and transceivers, andWWAN antenna cables and transceivers)
 658543-001 Heat sink for use only on HP ProBook 6475b Notebook PC computer models (includes replacementthermal material)
 659083-001 6-cell, 51-Wh, 2.55-Ah, Li-ion battery
 664663-001 Intel Celeron B840 1.90-GHz processor for use only on HP ProBook 6470b Notebook PC computermodels (1333-MHz, 2.0-MB L3 cache, 35 W; includes replacement thermal material)
 668969-001 HP hs2350 HSPA+ Mobile Broadband Module
 669832-001 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter
 670034-001 8-GB memory module (PC3, 12800, 1600-MHz)
 670288-001 Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adaptor
 675791-001 HP lt2522 LTE/EV-DO Mobile Broadband Module
 675793-001 HP lt2523 LTE/HSPA+ Mobile Broadband Module
 675794-001 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter
 677152-001 Intel Core i3-2370M 2.40-GHz processor for use only on HP ProBook 6470b Notebook PCcomputer models (1333-MHz FSB, 3.0-MB L3 cache, 35 W; includes replacement thermal material)
 680645-001 Intel Dual Core i5-3210M 2.50-GHz processor for use only on HP ProBook 6470b Notebook PCcomputer models (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includesreplacement thermal material)
 680646-001 Intel Quad Core i7-3610QM 2.30-GHz for use only on HP ProBook 6470b Notebook PC computermodels (SC turbo up to 3.30-GHz; 1600-MHz FSB, 6.0-MB L3 cache, 45 W; includes replacementthermal material)
 681283-001 Intel Quad Core i7-3720QM 2.60-GHz for use only on HP ProBook 6470b Notebook PC computermodels (SC turbo up to 3.60-GHz; 1600-MHz FSB, 6.0-MB L3 cache, 45 W; includes replacementthermal material)
 681284-001 Intel Quad Core i7-3820QM 2.70-GHz processor for use only on HP ProBook 6470b NotebookPC computer models (SC turbo up to 3.70-GHz; 1600-MHz FSB, 8.0-MB L3 cache, 45 W; includesreplacement thermal material)
 681952-001 Intel Dual Core i5-3320M 2.60-GHz processor for use only on HP ProBook 6470b Notebook PCcomputer models (SC turbo up to 3.30-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includesreplacement thermal material)
 681953-001 Intel Dual Core i5-3360M 2.80-GHz processor for use only on HP ProBook 6470b Notebook PCcomputer models (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includesreplacement thermal material)
 681954-001 Intel Dual Core i7-3520M 2.90-GHz processor for use only on HP ProBook 6470b Notebook PCcomputer models (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0-MB L3 cache, 35 W; includesreplacement thermal material)
 682417-001 Intel Core i3-3110M 2.40-GHz processor for use only on HP ProBook 6470b Notebook PCcomputer models (1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes replacement thermal material)
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Spare part number Description
 683046-001 AMD A10-4600M 3.20-GHz/2.30-GHz processor with Radeon HD 7660G graphics (4.0-MB L2cache, 1600-MHz DDR3, quad core, 35 W; includes replacement thermal material)
 683047-001 AMD A6-4400M 3.20-GHz/2.70-GHz processor with Radeon HD 7520G graphics (1.0-MB L2cache, 1600-MHz DDR3, dual core, 35 W; includes replacement thermal material)
 683048-001 AMD A8-4500M 2.80-GHz/1.90-GHz processor with Radeon HD 7640G graphics (4.0-MB L2cache, 1600-MHz DDR3, quad core, 35 W; includes replacement thermal material)
 683781-001 Display bezel for use only on HP ProBook 6470b Notebook PC computer models
 683801-001 500-GB, 7200-rpm, 9.5-mm SED hard drive (does not include hard drive bracket or screws)
 NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, sparepart number 642774-001.
 684326-001 Service cover
 684328-001 DVD-ROM Drive
 684329-001 DVD±RW Double-Layer with SuperMulti Drive
 684330-001 Blu-ray ROM DVD±RW SuperMulti DL Drive
 684332-001 Keyboard with pointing stick for use in the United States (includes keyboard cable and pointingstick cable)
 684332-031 Keyboard with pointing stick for use in the United Kingdom and Singapore (includes keyboardcable and pointing stick cable)
 684332-041 Keyboard with pointing stick for use in Germany (includes keyboard cable and pointing stick cable)
 684332-051 Keyboard with pointing stick for use in France (includes keyboard cable and pointing stick cable)
 684332-061 Keyboard with pointing stick for use in Italy (includes keyboard cable and pointing stick cable)
 684332-071 Keyboard with pointing stick for use in Spain (includes keyboard cable and pointing stick cable)
 684332-081 Keyboard with pointing stick for use in Denmark (includes keyboard cable and pointing stick cable)
 684332-091 Keyboard with pointing stick for use in Norway (includes keyboard cable and pointing stick cable)
 684332-131 Keyboard with pointing stick for use in Portugal (includes keyboard cable and pointing stick cable)
 684332-141 Keyboard with pointing stick for use in Turkey (includes keyboard cable and pointing stick cable)
 684332-161 Keyboard with pointing stick for use in Latin America (includes keyboard cable and pointingstick cable)
 684332-171 Keyboard with pointing stick for use in Saudi Arabia (includes keyboard cable and pointingstick cable)
 684332-201 Keyboard with pointing stick for use in Brazil (includes keyboard cable and pointing stick cable)
 684332-211 Keyboard with pointing stick for use in Hungary (includes keyboard cable and pointing stick cable)
 684332-251 Keyboard with pointing stick for use in Russia (includes keyboard cable and pointing stick cable)
 684332-261 Keyboard with pointing stick for use in Bulgaria (includes keyboard cable and pointing stick cable)
 684332-271 Keyboard with pointing stick for use in Romania (includes keyboard cable and pointing stick cable)
 684332-281 Keyboard with pointing stick for use in Thailand (includes keyboard cable and pointing stick cable)
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Spare part number Description
 684332-291 Keyboard with pointing stick for use in Japan (includes keyboard cable and pointing stick cable)
 684332-A41 Keyboard with pointing stick for use in Belgium (includes keyboard cable and pointing stick cable)
 684332-AB1 Keyboard with pointing stick for use in Taiwan (includes keyboard cable and pointing stick cable)
 684332-AD1 Keyboard with pointing stick for use in South Korea (includes keyboard cable and pointingstick cable)
 684332-B31 Keyboard with pointing stick for use in the Netherlands (includes keyboard cable and pointingstick cable)
 684332-B71 Keyboard with pointing stick for use in Sweden and Finland (includes keyboard cable and pointingstick cable)
 684332-BA1 Keyboard with pointing stick for use in Slovenia (includes keyboard cable and pointing stick cable)
 684332-BB1 Keyboard with pointing stick for use in Israel (includes keyboard cable and pointing stick cable)
 684332-BG1 Keyboard with pointing stick for use in Switzerland (includes keyboard cable and pointingstick cable)
 684332-D61 Keyboard with pointing stick for use in India (includes keyboard cable and pointing stick cable)
 684332-DB1 Keyboard with pointing stick for use in Canada (includes keyboard cable and pointing stick cable)
 684332-DD1 Keyboard with pointing stick for use in Iceland (includes keyboard cable and pointing stick cable)
 684332-DJ1 Keyboard with pointing stick for use in Greece (includes keyboard cable and pointing stick cable)
 684332-FL1 Keyboard with pointing stick for use in the Czech Republic and Slovakia (includes keyboard cableand pointing stick cable)
 684332-FP1 Keyboard with pointing stick for use in Northwest Africa (includes keyboard cable and pointingstick cable)
 684333-001 Keyboard without pointing stick for use in the United States (includes keyboard cable)
 684333-031 Keyboard without pointing stick for use in the United Kingdom and Singapore(includes keyboard cable)
 684333-041 Keyboard without pointing stick for use in Germany (includes keyboard cable)
 684333-051 Keyboard without pointing stick for use in France (includes keyboard cable)
 684333-061 Keyboard without pointing stick for use in Italy (includes keyboard cable)
 684333-071 Keyboard without pointing stick for use in Spain (includes keyboard cable)
 684333-081 Keyboard without pointing stick for use in Denmark (includes keyboard cable)
 684333-091 Keyboard without pointing stick for use in Norway (includes keyboard cable)
 684333-131 Keyboard without pointing stick for use in Portugal (includes keyboard cable)
 684333-141 Keyboard without pointing stick for use in Turkey (includes keyboard cable)
 684333-161 Keyboard without pointing stick for use in Latin America (includes keyboard cable)
 684333-171 Keyboard without pointing stick for use in Saudi Arabia (includes keyboard cable)
 684333-201 Keyboard without pointing stick for use in Brazil (includes keyboard cable)
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Spare part number Description
 684333-211 Keyboard without pointing stick for use in Hungary (includes keyboard cable)
 684333-251 Keyboard without pointing stick for use in Russia (includes keyboard cable)
 684333-261 Keyboard without pointing stick for use in Bulgaria (includes keyboard cable)
 684333-271 Keyboard without pointing stick for use in Romania (includes keyboard cable)
 684333-281 Keyboard without pointing stick for use in Thailand (includes keyboard cable)
 684333-291 Keyboard without pointing stick for use in Japan (includes keyboard cable)
 684333-A41 Keyboard without pointing stick for use in Belgium (includes keyboard cable)
 684333-AB1 Keyboard without pointing stick for use in Taiwan (includes keyboard cable)
 684333-AD1 Keyboard without pointing stick for use in South Korea (includes keyboard cable)
 684333-B31 Keyboard without pointing stick for use in the Netherlands (includes keyboard cable)
 684333-B71 Keyboard without pointing stick for use in Sweden and Finland (includes keyboard cable)
 684333-BA1 Keyboard without pointing stick for use in Slovenia (includes keyboard cable)
 684333-BB1 Keyboard without pointing stick for use in Israel (includes keyboard cable)
 684333-BG1 Keyboard without pointing stick for use in Switzerland (includes keyboard cable)
 684333-D61 Keyboard without pointing stick for use in India (includes keyboard cable)
 684333-DB1 Keyboard without pointing stick for use in Canada (includes keyboard cable)
 684333-DD1 Keyboard without pointing stick for use in Iceland (includes keyboard cable)
 684333-DJ1 Keyboard without pointing stick for use in Greece (includes keyboard cable)
 684333-FL1 Keyboard without pointing stick for use in the Czech Republic and Slovakia(includes keyboard cable)
 684333-FP1 Keyboard without pointing stick for use in Northwest Africa (includes keyboard cable)
 684334-001 Base enclosure for use only on computer models equipped with WWAN capability (includes rubberfeet, service cover release latch assembly, and battery release latch assembly)
 684336-001 Top cover equipped with pointing stick buttons and a fingerprint reader for use only on(includes TouchPad)
 684338-001 Top cover not equipped with pointing stick buttons and a fingerprint reader for use only on(includes TouchPad)
 684339-001 Latch Kit (includes service cover release latch assembly components and battery release latchassembly components)
 684341-001 System board for use only on HP ProBook 6475b Notebook PC computer models equipped withWWAN capability in all countries and regions except the People's Republic of China andthe Ukraine (includes replacement thermal material)
 684342-001 System board for use only on HP ProBook 6475b Notebook PC computer models not equipped withWWAN capability in all countries and regions except the People's Republic of China andthe Ukraine (includes replacement thermal material)
 684346-001 Webcam/microphone module
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 684347-001 14.0-in, LED, SVA, HD, AntiGlare display panel for use on all computer models
 684348-001 14.0-in, LED, SVA, HD+, AntiGlare display panel for use on all computer models
 684351-001 Plastics Kit (includes ExpressCard slot space saver, optical drive bay space saver, RJ-11 jack plug,and wireless antenna clips)
 684353-001 Smart Card reader
 685990-001 AMD A4-4300M 3.00-GHz/2.50-GHz processor with Radeon HD 7420G graphics (1.0-MB L2cache, 1600-MHz DDR3, dual core, 35 W; includes replacement thermal material)
 685999-001 Display bezel for use only on HP ProBook 6470b Notebook PC computer models
 686021-001 Heat sink for use only on HP ProBook 6470b Notebook PC computer models equipped with agraphics subsystem with discrete memory (includes replacement thermal material)
 686032-001 Screw Kit
 686035-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with theIntel HM76 chipset, a graphics subsystem with UMA memory, but not WWAN capability in allcountries and regions except the People's Republic of China and the Ukraine (includes replacementthermal material)
 686036-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with theIntel HM76 chipset, a graphics subsystem with UMA memory, and with WWAN capability in allcountries and regions except the People's Republic of China and the Ukraine (includes replacementthermal material)
 686037-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with theIntel QM77 chipset, a graphics subsystem with UMA memory, and with WWAN capability in allcountries and regions except the People's Republic of China and the Ukraine (includes replacementthermal material)
 686038-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with theIntel HM76 chipset, a graphics subsystem with discrete memory, and with WWAN capability in allcountries and regions except the People's Republic of China and the Ukraine (includes replacementthermal material)
 686039-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with theIntel QM77 chipset, a graphics subsystem with discrete memory, and with WWAN capability in allcountries and regions except the People's Republic of China and the Ukraine (includes replacementthermal material)
 686046-001 14.0-in, LED, FLT, HD, AntiGlare display panel for use only on HP ProBook 6470b Notebook PCcomputer models
 686047-001 14.0-in, LED, FLT, HD+, AntiGlare display panel for use only on HP ProBook 6470b Notebook PCcomputer models
 687224-001 Base enclosure for use only on computer models not equipped with WWAN capability (includesrubber feet, service cover release latch assembly, and battery release latch assembly)
 689954-001 24-GB flash cache module for use only on HP ProBook 6470b Notebook PC computer models
 690036-001 System board for use only on HP ProBook 6475b Notebook PC computer models equipped withWWAN capability in the People's Republic of China and the Ukraine (includes replacementthermal material)
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Spare part number Description
 690037-001 System board for use only on HP ProBook 6475b Notebook PC computer models not equipped withWWAN capability in the People's Republic of China and the Ukraine (includes replacementthermal material)
 690229-001 128-GB SATA III solid-state drive or use only on HP ProBook 6470b Notebook PC computer models
 691466-001 256-GB SATA III self-encrypting solid-state drive for use only on HP ProBook 6470b Notebook PCcomputer models
 691711-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with theIntel HM76 chipset, a graphics subsystem with UMA memory, but without WWAN capability onlyin the People's Republic of China and the Ukraine (includes replacement thermal material)
 691712-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with theIntel HM76 chipset, a graphics subsystem with UMA memory, and with WWAN capability only inthe People's Republic of China and the Ukraine (includes replacement thermal material)
 691713-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with theIntel QM77 chipset, a graphics subsystem with UMA memory, and with WWAN capability only inthe People's Republic of China and the Ukraine (includes replacement thermal material)
 691714-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with theIntel HM76 chipset, a graphics subsystem with discrete memory, and with WWAN capability onlyin the People's Republic of China and the Ukraine (includes replacement thermal material)
 691715-001 System board for use only on HP ProBook 6470b Notebook PC computer models equipped with theIntel QM77 chipset, a graphics subsystem with discrete memory, and with WWAN capability onlyin the People's Republic of China and the Ukraine (includes replacement thermal material)
 692097-001 180-GB SATA III solid-state drive for use only on HP ProBook 6470b Notebook PCcomputer models
 692425-001 128-GB SATA III solid-state drive for use only on HP ProBook 6475b Notebook PCcomputer models
 693063-001 Display Cable Kit for use only on computer models equipped with an HD+ display assembly
 693064-001 Display Cable Kit for use only on computer models equipped with an HD display assembly
 693371-001 Heat sink for use only on HP ProBook 6470b Notebook PC computer models equipped with agraphics subsystem with UMA memory (includes replacement thermal material)
 693710-001 65-W HP Smart AC adapter (RC/V, EM, 3-wire)
 693711-001 65-W HP Smart AC adapter (non-PFC, 3-wire)
 693712-001 90-W HP Smart AC adapter (PFC, 3-wire)
 693713-001 90-W HP Smart AC adapter (PFC, EM, 3-wire)
 693863-001 160-GB SATA II solid-state drive for use only on HP ProBook 6470b Notebook PC computer models
 697439-001 Display Miscellaneous Kit
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4 Removal and replacementprocedures
 Preliminary replacement requirements
 Tools required
 You will need the following tools to complete the removal and replacement procedures:
 ● Flat-bladed screw driver
 ● Magnetic screw driver
 ● Phillips P0 and P1 screw drivers
 Service considerations
 The following sections include some of the considerations that you must keep in mind duringdisassembly and assembly procedures.
 NOTE: As you remove each subassembly from the computer, place the subassembly (and allaccompanying screws) away from the work area to prevent damage.
 Plastic parts
 CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Usecare when handling the plastic parts. Apply pressure only at the points designated in themaintenance instructions.
 Cables and connectors
 CAUTION: When servicing the computer, be sure that cables are placed in their proper locationsduring the reassembly process. Improper cable placement can damage the computer.
 Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseator seat the cables during removal and insertion. Handle cables by the connector whenever possible. Inall cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way thatthey cannot be caught or snagged by parts being removed or replaced. Handle flex cables withextreme care; these cables tear easily.
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Drive handling
 CAUTION: Drives are fragile components that must be handled with care. To prevent damage to thecomputer, damage to a drive, or loss of information, observe these precautions:
 Before removing or inserting a hard drive, shut down the computer. If you are unsure whether thecomputer is off or in Hibernation, turn the computer on, and then shut it down through theoperating system.
 Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,avoid touching the connector.
 Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive andbe sure that the optical drive tray is closed.
 Handle drives on surfaces covered with at least one inch of shock-proof foam.
 Avoid dropping drives from any height onto any surface.
 After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
 Avoid exposing an internal hard drive to products that have magnetic fields, such as monitorsor speakers.
 Avoid exposing a drive to temperature extremes or liquids.
 If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protectivepackaging and label the package “FRAGILE.”
 Grounding guidelines
 Electrostatic discharge damage
 Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structuredetermine the degree of sensitivity. Networks built into many integrated circuits provide someprotection, but in many cases, ESD contains enough power to alter device parameters or meltsilicon junctions.
 A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices ormicrocircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
 An electronic device exposed to ESD may not be affected at all and can work perfectly throughout anormal cycle. Or the device may function normally for a while, then degrade in the internal layers,reducing its life expectancy.
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CAUTION: To prevent damage to the computer when you are removing or installing internalcomponents, observe these precautions:
 Keep components in their electrostatic-safe containers until you are ready to install them.
 Before touching an electronic component, discharge static electricity by using the guidelines describedin this section.
 Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
 If you remove a component, place it in an electrostatic-safe container.
 The following table shows how humidity affects the electrostatic voltage levels generated bydifferent activities.
 CAUTION: A product can be degraded by as little as 700 V.
 Typical electrostatic voltage levels
 Relative humidity
 Event 10% 40% 55%
 Walking across carpet 35,000 V 15,000 V 7,500 V
 Walking across vinyl floor 12,000 V 5,000 V 3,000 V
 Motions of bench worker 6,000 V 800 V 400 V
 Removing DIPS from plastic tube 2,000 V 700 V 400 V
 Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V
 Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
 Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
 Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines
 Follow these grounding guidelines when packaging and transporting equipment:
 ● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.
 ● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
 ● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
 ● Place items on a grounded surface before removing items from their containers.
 ● Always be properly grounded when touching a component or assembly.
 ● Store reusable ESD-sensitive parts from assemblies in protective packaging ornonconductive foam.
 ● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure thatmechanized equipment used for moving materials is wired to ground and that proper materialsare selected to avoid static charging. When grounding is not possible, use an ionizer to dissipateelectric charges.
 Workstation guidelines
 Follow these grounding workstation guidelines:
 ● Cover the workstation with approved static-shielding material.
 ● Use a wrist strap connected to a properly grounded work surface and use properly grounded toolsand equipment.
 ● Use conductive field service tools, such as cutters, screw drivers, and vacuums.
 ● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials.
 ● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aidsand Styrofoam.
 ● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handlethese items only at static-free workstations.
 ● Avoid contact with pins, leads, or circuitry.
 ● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
 Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
 ● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible strapswith a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,use alligator clips to connect a wrist strap.
 ● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)can be used at standing workstations and are compatible with most types of shoes or boots. Onconductive floors or dissipative floor mats, use foot straps on both feet with a minimum of onemegohm resistance between the operator and ground. To be effective, the conductive must beworn in contact with the skin.
 The following grounding equipment is recommended to prevent electrostatic damage:
 ● Antistatic tape
 ● Antistatic smocks, aprons, and sleeve protectors
 ● Conductive bins and other assembly or soldering aids
 ● Nonconductive foam
 ● Conductive tabletop workstations with ground cords of one megohm resistance
 ● Static-dissipative tables or floor mats with hard ties to the ground
 ● Field service kits
 ● Static awareness labels
 ● Material-handling packages
 ● Nonconductive plastic bags, tubes, or boxes
 ● Metal tote boxes
 ● Electrostatic voltage levels and protective materials
 The following table lists the shielding protection provided by antistatic bags and floor mats.
 Material Use Voltage protection level
 Antistatic plastics Bags 1,500 V
 Carbon-loaded plastic Floor mats 7,500 V
 Metallized laminate Floor mats 5,000 V
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Component replacement proceduresThis chapter provides removal and replacement procedures.
 There are as many as 84 screws that must be removed, replaced, and/or loosened when servicing thecomputer. Make special note of each screw size and location during removal and replacement.
 Service tag
 When ordering parts or requesting information, provide the computer serial number and model numberprovided on the service tag. It is necessary to remove the battery to obtain these numbers. See Batteryon page 55 for battery removal instructions.
 Item Component Description
 (1) Product name This is the product name affixed to the front ofthe computer.
 (2) Serial number (s/n) This is an alphanumeric identifier that is unique toeach product.
 (3) Part number/Product number (p/n) This number provides specific information about theproduct’s hardware components. The part number helpsa service technician determine what components andparts are needed.
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Item Component Description
 (4) Warranty period This number describes the duration of the warrantyperiod for the computer.
 (5) Model description This is the alphanumeric identifier used to locatedocuments, drivers, and support for the computer.
 Computer feet
 The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare partnumber 641831-001. There are four rectangular rubber feet (1) and three square rubber feet (2) thatattach to the base enclosure and service cover in the locations illustrated below.
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Battery
 Description Spare part number
 9-cell, 100-Wh, 3.00-Ah 631243-001
 9-cell, 100-Wh, 3.00-Ah 634087-001
 9-cell, 73-Wh, 2.20-Ah 634089-001
 6-cell, 62-Wh, 2.80-Ah 628668-001
 6-cell, 55-Wh, 2.80-Ah 628670-001
 6-cell, 51-Wh, 2.55-Ah 659083-001
 3-cell, 31-Wh, 2.80-Ah 628664-001
 Before disassembling the computer, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 Remove the battery:
 1. Position the computer upside-down on a flat surface, with the battery bay toward you.
 2. Slide the battery release latch (1) to release the battery.
 3. Remove the battery (2) from the computer.
 Install the battery by inserting it into the battery bay until you hear a click.
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SIM
 NOTE: This section applies only to computer models with WWAN capability.
 NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling thecomputer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.
 Before removing the SIM, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 Remove the SIM:
 1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)
 2. Remove the SIM (2) from the SIM slot.
 Reverse this procedure to install the SIM.
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Service cover
 Description Spare part number
 Service cover 684326-001
 Before removing the service cover, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 Remove the service cover:
 1. Slide the release latch (1) and remove the locking screw (if installed) (2).
 2. Slide the release latch (3) to disengage the door from the computer.
 3. Slide the door toward the front of the computer (4), and then lift the door off the computer (5).
 Reverse the removal procedures to install the service cover.
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Optical drive
 NOTE: The optical drive spare part kit includes an optical drive bezel and optical drive bracket.
 Description Spare part number
 Blu-ray ROM DVD±RW SuperMulti DL Drive 684330-001
 DVD±RW Double-Layer with SuperMulti Drive 684329-001
 DVD-ROM Drive 684328-001
 Before removing the optical drive, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 5. Remove the service cover (see Service cover on page 57).
 Remove the optical drive:
 1. Position the computer upside-down with the right side toward you.
 2. Loosen the captive Phillips screw (1) that secures the optical drive to the computer.
 3. Use a flat-blade screw driver or similar tool to press on the optical drive bracket tab (2) to releasethe optical drive.
 58 Chapter 4 Removal and replacement procedures

Page 67
                        

4. Remove the optical drive (3) from the computer.
 5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear paneltoward you.
 6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to theoptical drive.
 7. Remove the optical drive bracket (2).
 Reverse this procedure to reassemble and install the optical drive.
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Upgrade bay
 Description Spare part number
 Upgrade bay (includes bezel and bracket) 643926-001
 Before removing the upgrade bay, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 5. Remove the service cover (see Service cover on page 57).
 Remove the upgrade bay:
 1. Position the computer upside-down with the right side toward you.
 2. Remove the four Phillips PM2.0×4.0 screws that secure the upgrade bay assembly to thecomputer.
 3. Loosen the captive Phillips screw that secures the upgrade bay drive in the upgrade bay (1).
 4. Use a flat-blade screw driver or similar tool to press on the upgrade bay bracket tab (2) to releasethe upgrade bay.
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5. Remove the upgrade bay (3) from the computer.
 Reverse this procedure to install the upgrade bay.
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Hard drive
 NOTE: The hard drive spare part kit does not include the hard drive bracket or screws.
 Description Spare part number
 750-GB, 7200-rpm, 9.5-mm 633252-001
 500-GB, 7200-rpm, 9.5-mm SED 683801-001
 500-GB, 7200-rpm, 9.5-mm 634925-001
 320-GB, 7200-rpm, 9.5-mm 634862-001
 Hard Drive Hardware Kit (includes hard drive bracket and screws) 642774-001
 Before removing the hard drive, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 5. Remove the service cover (see Service cover on page 57).
 Remove the hard drive:
 1. Loosen the three Phillips screws (1) that secure the hard drive to the computer.
 2. Use the hard drive tab (2) to slide the hard drive to the right to disconnect it from the systemboard.
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3. Remove the hard drive (3) from the hard drive bay.
 4. If it is necessary to disassemble the hard drive, perform the following steps:
 a. Remove the four Phillips PM3.0×3.0 screws (1) that secure the hard drive bracket to thehard drive.
 b. Remove the hard drive bracket (2) from the hard drive. The hard drive bracket and screwsare available in the Hard Drive Hardware Kit, spare part number 642774-001.
 Reverse this procedure to reassemble and install the hard drive.
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RTC battery
 Description Spare part number
 RTC battery (includes cable and double-sided tape) 651948-001
 Before removing the RTC battery, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Optical drive (see Optical drive on page 58)
 c. Hard drive (see Hard drive on page 62)
 d. Modem module (see Modem module on page 73)
 e. Keyboard (see Keyboard on page 76)
 f. Base enclosure (see Base enclosure on page 80)
 Remove the RTC battery:
 1. Disconnect the RTC battery cable (1) from the system board.
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2. Detach the RTC battery (2) from the base enclosure. (The RTC battery is attached to thebase enclosure with double-sided tape.)
 3. Remove the RTC battery.
 Reverse this procedure to install the RTC battery.
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Memory module
 NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom ofthe computer.
 Description Spare part number
 8-GB memory module (PC3, 12800, 1600-MHz) 670034-001
 4-GB memory module (PC3, 12800, 1600-MHz) 641369-001
 2-GB memory module (PC3, 12800, 1600-MHz) 652972-001
 Update BIOS before adding memory modules
 Before adding new memory, make sure you update the computer to the latest BIOS.
 CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory mayresult in various system problems.
 To update BIOS:
 1. Navigate to www.hp.com.
 2. Click Support & Drivers > click Drivers & Software.
 3. In the Enter a product name/number box, type the computer model information, and thenclick Search.
 4. Click the link for the computer model.
 5. Select the operating system, and then click Next.
 6. Under Step 2: Select a Download, click the BIOS link.
 7. Click the link for the most recent BIOS.
 8. Click the Download button, and then follow the on-screen instructions.
 Before removing a memory module, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 5. Remove the service cover (see Service cover on page 57).
 Remove the memory module:
 1. Spread the retaining tabs (1) on each side of the memory module slot to release the memorymodule. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.
 NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into thememory module slot.
 NOTE: The computer uses two memory slots. The top slot houses the expansion memory moduleand is shown in the first image below. The bottom slot houses the primary memory module and isshown in the second image below.
 Reverse this procedure to install a memory module.
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WWAN module
 NOTE: The WWAN module and the WLAN module are not interchangeable.
 Description Spare part number
 HP lt2523 LTE/HSPA+ Mobile Broadband Module 675793-001
 HP lt2522 LTE/EV-DO Mobile Broadband Module 675791-001
 HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001
 HP hs2350 HSPA+ Mobile Broadband Module 668969-001
 Before removing the WWAN module, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 5. Remove the service cover (see Service cover on page 57).
 Remove the WWAN module:
 1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
 NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.
 2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to thebase enclosure. (The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.
 NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.
 NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module, theprotective sleeves must be installed on the antenna connectors, as shown in the following illustration.
 Reverse this procedure to install the WWAN module.
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WLAN module
 Description Spare part number
 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter 675794-001
 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter 669832-001
 Intel Centrino Advanced-N 6205 WLAN module 631954-001
 Intel Centrino Ultimate-N 6300 WLAN module 572511-001
 Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adaptor 670288-001
 CAUTION: To prevent an unresponsive system, replace the wireless module only with a wirelessmodule authorized for use in the computer by the governmental agency that regulates wireless devicesin your country or region. If you replace the module and then receive a warning message, remove themodule to restore device functionality, and then contact technical support.
 Before removing the WLAN module, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 5. Remove the service cover (see Service cover on page 57).
 Remove the WLAN module:
 1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
 NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminallabeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminallabeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellowWLAN antenna cable connects to the middle terminal on the WLAN module.
 2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to thebase enclosure. (The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.
 NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.
 NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protectivesleeves must be installed on the antenna connectors, as shown in the following illustration.
 Reverse this procedure to install the WLAN module.
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Bluetooth module
 NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetoothmodule cable is included in the Cable Kit, spare part number 641830-001.
 Description Spare part number
 Bluetooth module 4.0 EDR 655792-001
 Before removing the Bluetooth module, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 5. Remove the service cover (see Service cover on page 57).
 Remove the Bluetooth module:
 1. Disconnect the Bluetooth module cable (1) from the system board.
 2. Release the Bluetooth module (2) from the clip built into the base enclosure.
 3. Remove the Bluetooth module.
 Reverse this procedure to install the Bluetooth module.
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Modem module
 NOTE: The modem module spare part kit does not include an RJ-11 jack cable. The RJ-11 jack cableis included in the Cable Kit, spare part number 641830-001.
 Description Spare part number
 Modem module 628824-001
 Before removing the modem module, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 5. Remove the service cover (see Service cover on page 57).
 Remove the modem module:
 1. Remove the two Phillips PM2.0×3.0 screws (1) that secure the modem module to the systemboard.
 2. Disconnect the modem module (2) from the system board by lifting it straight up.
 Component replacement procedures 73

Page 82
                        

3. Disconnect the modem module cable (3) from the modem module.
 4. Remove the modem module.
 Reverse this procedure to install the modem module.
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Fan
 Description Spare part number
 Fan (includes cable) 641839-001
 Before removing the fan, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 5. Remove the service cover (see Service cover on page 57).
 Remove the fan:
 1. Disconnect the fan cable (1) from the system board.
 2. Loosen the three captive Phillips screws (2) that secure the fan to the top cover.
 3. Remove the fan (3).
 Reverse this procedure to install the fan.
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Keyboard
 For use in country/region Spare partnumber
 For use in country/region Spare partnumber
 Keyboard with pointing stick (includes keyboard cable and pointing stick cable):
 For use in Belgium 684332-A41 For use in Norway 684332-091
 For use in Brazil 684332-201 For use in Northwest Africa 684332-FP1
 For use in Bulgaria 684332-261 For use in Portugal 684332-131
 For use in Canada 684332-DB1 For use in Romania 684332-271
 For use in the Czech Republicand Slovakia
 684332-A81 For use in Russia 684332-251
 For use in Denmark 684332-081 For use in Saudi Arabia 684332-171
 For use in France 684332-051 For use in Slovenia 684332-BA1
 For use in Germany 684332-041 For use in South Korea 684332-AD1
 For use in Greece 684332-DJ1 For use in Spain 684332-071
 For use in Hungary 684332-211 For use in Sweden and Finland 684332-B71
 For use in Iceland 684332-DD1 For use in Switzerland 684332-BG1
 For use in India 684332-D61 For use in Taiwan 684332-AB1
 For use in Israel 684332-BB1 For use in Thailand 684332-281
 For use in Italy 684332-061 For use in Turkey 684332-141
 For use in Japan 684332-291 For use in the United Kingdomand Singapore
 684332-031
 For use in Latin America 684332-161 For use in the United States 684332-001
 For use in the Netherlands 684332-B31
 Keyboard without pointing stick (includes keyboard cable):
 For use in Belgium 684333-A41 For use in Norway 684333-091
 For use in Brazil 684333-201 For use in Northwest Africa 684333-FP1
 For use in Bulgaria 684333-261 For use in Portugal 684333-131
 For use in Canada 684333-DB1 For use in Romania 684333-271
 For use in the Czech Republicand Slovakia
 684333-A81 For use in Russia 684333-251
 For use in Denmark 684333-081 For use in Saudi Arabia 684333-171
 For use in France 684333-051 For use in Slovenia 684333-BA1
 For use in Germany 684333-041 For use in South Korea 684333-AD1
 For use in Greece 684333-DJ1 For use in Spain 684333-071
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For use in country/region Spare partnumber
 For use in country/region Spare partnumber
 For use in Hungary 684333-211 For use in Sweden and Finland 684333-B71
 For use in Iceland 684333-DD1 For use in Switzerland 684333-BG1
 For use in India 684333-D61 For use in Taiwan 684333-AB1
 For use in Israel 684333-BB1 For use in Thailand 684333-281
 For use in Italy 684333-061 For use in Turkey 684333-141
 For use in Japan 684333-291 For use in the United Kingdomand Singapore
 684333-031
 For use in Latin America 684333-161 For use in the United States 684333-001
 For use in the Netherlands 684333-B31
 Before removing the keyboard, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55).
 5. Remove the service cover (see Service cover on page 57).
 Remove the keyboard:
 1. Loosen the three Phillips captive screws that secure the keyboard to the computer.
 2. Rest and secure the computer on its right side.
 3. Partially open the computer.
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4. Insert a screw driver or similar thin tool into the keyboard release opening in the battery bay, andthen press on the back of the keyboard until the keyboard disengages from the computer.
 5. Turn the computer right-side up with the front toward you.
 6. Lift the rear edge of the keyboard (1), and then swing the keyboard up and forward (2) until itrests upside down on the palm rest.
 7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, andthen disconnect the keyboard cable (2) from the keyboard.
 NOTE: The pointing stick cable is present on select models only.
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8. Release the ZIF connector (3) to which the pointing stick cable is attached, and then disconnectthe pointing stick cable (4) from the system board.
 9. Remove the keyboard.
 Reverse this procedure to install the keyboard.
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Base enclosure
 NOTE: The base enclosure spare part kit includes seven rubber feet, the service cover release latchassembly, and the battery release latch assembly.
 Description Spare part number
 For use only on computer models equipped with WWAN capability 684334-001
 For use only on computer models not equipped with WWAN capability 687224-001
 Before removing the base enclosure, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Optical drive (see Optical drive on page 58)
 c. Hard drive (see Hard drive on page 62)
 d. Modem module (see Modem module on page 73)
 e. Keyboard (see Keyboard on page 76)
 NOTE: When replacing the base enclosure, be sure to remove the following components from thedefective base enclosure and install them on the replacement base enclosure:
 ● Bluetooth module and cable (see Bluetooth module on page 72)
 ● Speaker assembly (see Speaker assembly on page 84)
 ● RJ-11 jack assembly (see RJ-11 jack cable on page 85)
 Remove the base enclosure:
 1. Close the computer.
 2. Turn the computer upside down, with the front toward you.
 3. Remove the three rubber screw covers (1) and (2). The rubber screw covers are included in theRubber Kit, spare part number 641831-001.
 NOTE: The rubber screw covers in the front/right and rear/left corners (1) are smaller than thescrew cover in the rear/right corner.
 4. Remove the seven Torx PM2.5×6.0 screws (3) that secure the base enclosure to the computer.
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5. Remove the four Phillips PM2.5×3.0 screws from the battery bay (4) that secure the baseenclosure to the computer.
 6. Remove the two Phillips PM2.5×3.0 screws (1) from the hard drive bay that secure the baseenclosure to the computer.
 7. Remove the three Phillips PM2.0×3.0 screws (2) from the optical drive bay that secure the baseenclosure to the computer.
 8. Position the computer with the battery bay toward you.
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9. Remove the four Torx TM2.5×8.0 screws from the rear panel of the computer.
 10. Remove the wireless cables from the clips (1) and routing channel built into the base enclosure.
 11. Disconnect the speaker cable (2) from the system board.
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12. Remove the base enclosure by lifting it straight up from the computer.
 NOTE: When replacing the bottom cover, make sure to remove the RJ-11 jack cover from the slot inthe base enclosure if the repaired unit includes a modem.
 NOTE: Thoroughly clean the thermal pad material from the surfaces of the base enclosure (1) andthe PCH chip (2) each time you remove the base enclosure. All base enclosure and system board sparepart kits include replacement thermal pad material.
 Reverse this procedure to install the base enclosure.
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Speaker assembly
 Description Spare part number
 Speaker assembly (includes cable) 641840-001
 Before removing the speaker assembly, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Optical drive (see Optical drive on page 58)
 c. Hard drive (see Hard drive on page 62)
 d. Modem module (see Modem module on page 73)
 e. Keyboard (see Keyboard on page 76)
 f. Base enclosure (see Base enclosure on page 80)
 Remove the speaker assembly:
 1. Turn the base enclosure right-side up, with the front toward you.
 2. Remove the two Phillips PM2.0×3.0 screws (1) that secure the speaker assembly to thebase enclosure.
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3. Remove the speaker assembly (2) from the base enclosure.
 Reverse this procedure to install the speaker assembly.
 RJ-11 jack cable
 NOTE: The RJ-11 jack cable is included in the Cable Kit, spare part number 641830-001.
 Before removing the RJ-11 jack cable, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Optical drive (see Optical drive on page 58)
 c. Hard drive (see Hard drive on page 62)
 d. Modem module (see Modem module on page 73)
 e. Keyboard (see Keyboard on page 76)
 f. Base enclosure (see Base enclosure on page 80)
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Remove the RJ-11 jack cable:
 1. Turn the base enclosure right-side up, with the front toward you.
 2. Release the RJ-11 jack from the clip (1) built into the base enclosure.
 3. Release the RJ-11 jack cable from the clips (2) and routing channel built into the base enclosure.
 4. Remove the RJ-11 jack cable.
 Reverse this procedure to install the RJ-11 jack cable.
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Service cover release latch assembly
 NOTE: The service cover release latch assembly components are included in the Latch Kit, spare partnumber 684339-001.
 Before removing the service cover release latch assembly, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Optical drive (see Optical drive on page 58)
 c. Hard drive (see Hard drive on page 62)
 d. Modem module (see Modem module on page 73)
 e. Keyboard (see Keyboard on page 76)
 f. Base enclosure (see Base enclosure on page 80)
 Remove the service cover release latch assembly:
 1. Position the base enclosure with the front toward you.
 2. Remove the service cover release latch actuator from the base enclosure.
 3. Turn the base enclosure right side up, with the front toward you.
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4. Remove the service cover release latch arm spring from the spring retention hooks on the servicecover release latch arm (1) and the base enclosure (2).
 5. Slide the service cover release latch arm (1) as far to the left as it will go.
 6. Flex the middle of the service cover release latch arm (2) up and back until it releases from thetrack built into the base enclosure.
 7. Lift the left end of the service cover release latch arm (3) out of the openings in the base enclosure.
 8. Swing the left end of the service cover release latch arm (1) toward the back of the computer.
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9. Release the right end of the service cover release latch arm (2) from the openings in thebase enclosure.
 10. Remove the service cover release latch arm.
 Reverse this procedure to install the service cover release latch assembly.
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Battery release latch assembly
 NOTE: The battery release latch assembly components are included in the Latch Kit, spare partnumber 684339-001.
 Before removing the battery release latch assembly, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Optical drive (see Optical drive on page 58)
 c. Hard drive (see Hard drive on page 62)
 d. Modem module (see Modem module on page 73)
 e. Keyboard (see Keyboard on page 76)
 f. Base enclosure (see Base enclosure on page 80)
 Remove the battery release latch assembly:
 1. Position the base enclosure with the front toward you.
 2. Remove the battery release latch actuator from the base enclosure.
 3. Turn the base enclosure right side up, with the front toward you.
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4. Remove the battery release latch arm spring from the spring retention hooks on thebase enclosure (1) and the battery release latch arm (2).
 5. Slide the battery release latch arm (1) as far to the right as it will go.
 6. Lift the right end of the battery release latch arm (2) until it is clear of the retention post built intothe base enclosure.
 7. Swing the right end of the battery release latch arm (3) clockwise until it is clear of the retentionpost built into the base enclosure.
 8. Slide the battery release latch arm (1) as far to the left as it will go.
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9. Swing the right end of the battery release latch arm (2) clockwise until the left end of the armrelease from the openings in the base enclosure.
 10. Remove the battery release latch arm.
 Reverse this procedure to install the battery release latch assembly.
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Function board
 Description Spare part number
 Function board 658142-001
 Before removing the function board, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Optical drive (see Optical drive on page 58)
 c. Hard drive (see Hard drive on page 62)
 d. Modem module (see Modem module on page 73)
 e. Keyboard (see Keyboard on page 76)
 f. Base enclosure (see Base enclosure on page 80)
 Remove the function board:
 1. Remove the wireless antenna cables (1) from the retention clip attached to the system board.
 2. Remove the three Phillips PM2.5×7.0 screws (2) that secure the function board to the computer.
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3. Slide the function board (3) to the left, and then remove the function board.
 Reverse this procedure to install the function board.
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System board
 NOTE: The system board spare part kit includes replacement thermal material.
 Description Spare part number
 For use only on HP ProBook 6475b Notebook PC computer models:
 For use on computer models equipped with WWAN capability in all countries and regions exceptin the People's Republic of China and the Ukraine
 684341-001
 For use on computer models not equipped with WWAN capability in all countries and regionsexcept in the People's Republic of China and the Ukraine
 684342-001
 For use on computer models equipped with WWAN capability only in the People's Republic ofChina and the Ukraine
 690036-001
 For use on computer models not equipped with WWAN capability only in the People's Republic ofChina and the Ukraine
 690037-001
 For use only on HP ProBook 6470b Notebook PC computer models:
 For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem withdiscrete memory, and WWAN capability in all countries and regions except in the People'sRepublic of China and the Ukraine
 686039-001
 For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem withUMA memory, and WWAN capability in all countries and regions except in the People's Republicof China and the Ukraine
 686037-001
 For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem withdiscrete memory, and WWAN capability in all countries and regions except in the People'sRepublic of China and the Ukraine
 686038-001
 For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem withUMA memory, and WWAN capability in all countries and regions except in the People's Republicof China and the Ukraine
 686036-001
 For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem withUMA memory, but without WWAN capability in all countries and regions except in the People'sRepublic of China and the Ukraine
 686035-001
 For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem withdiscrete memory, and WWAN capability only in the People's Republic of China and the Ukraine
 691715-001
 For use on computer models equipped with the Intel QM77 chipset, a graphics subsystem withUMA memory, and WWAN capability only in the People's Republic of China and the Ukraine
 691713-001
 For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem withdiscrete memory, and WWAN capability only in the People's Republic of China and the Ukraine
 691714-001
 For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem withUMA memory, and WWAN capability only in the People's Republic of China and the Ukraine
 691712-001
 For use on computer models equipped with the Intel HM76 chipset, a graphics subsystem withUMA memory, but without WWAN capability only in the People's Republic of China andthe Ukraine
 691711-001
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Before removing the system board, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Optical drive (see Optical drive on page 58)
 c. Hard drive (see Hard drive on page 62)
 d. Fan (see Fan on page 75)
 e. Modem module (see Modem module on page 73)
 f. Fan (see Fan on page 75)
 g. Keyboard (see Keyboard on page 76)
 h. Base enclosure (see Base enclosure on page 80)
 NOTE: When replacing the system board, be sure that the following components are removed fromthe defective system board and installed on the replacement system board:
 ● SIM (see SIM on page 56, if applicable)
 ● Memory module (see Memory module on page 66)
 ● WWAN module (see WWAN module on page 68)
 ● WLAN module (see WLAN module on page 70)
 ● Heat sink (see Heat sink on page 99)
 ● Processor (see Processor on page 102)
 Remove the system board:
 1. Position the computer right-side up, with the front toward you.
 2. Open the computer.
 3. Release the ZIF connector (1) to which the TouchPad cable is connected, and then disconnect theTouchPad cable (2) from the system board.
 4. Release the ZIF connector (3) to which the fingerprint reader board cable is connected, and thendisconnect the fingerprint reader board cable (4) from the system board.
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5. Disconnect the power connector cable (5) from the system board.
 6. Close the computer.
 7. Turn the computer upside down, with the battery bay toward you.
 8. Remove the Phillips PM2.5×5.0 screw (1) that secures the display panel cable ground loop (2) tothe computer.
 9. Release the display panel cable (3) from the retention clip (4) attached to the system board.
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10. Disconnect the display panel cable (5) from the system board.
 11. Remove the four Phillips PM2.5×5.0 screws that secure the system board to the top cover.
 12. Lift the right side of the system board (1) until it rests at an angle.
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13. Remove the system board (2) by sliding it up and to the right at an angle.
 Reverse this procedure to install the system board.
 Heat sink
 NOTE: The heat sink spare part kit includes replacement thermal material.
 Description Spare part number
 Heat sink for use only on HP ProBook 6475b Notebook PC computer models 658543-001
 Heat sink for use only on HP ProBook 6470b Notebook PC computer models equipped with agraphics subsystem with discrete memory
 686021-001
 Heat sink for use only on HP ProBook 6470b Notebook PC computer models equipped with agraphics subsystem with UMA memory
 693371-001
 Before removing the heat sink, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Hard drive (see Hard drive on page 62)
 c. Optical drive (see Hard drive on page 62)
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d. WLAN module (see WLAN module on page 70)
 e. WWAN module (see WWAN module on page 68)
 f. Fan (see Fan on page 75)
 g. Keyboard (see Keyboard on page 76)
 h. Base enclosure (see Base enclosure on page 80)
 i. System board (see System board on page 95)
 Remove the heat sink:
 NOTE: Steps 1 and 2 apply to computer models equipped with a graphics subsystem with discretememory. See steps 3 and 4 for heat sink removal information for computer models equipped with agraphics subsystem with UMA memory.
 1. Following the 1, 2, 3, 4, 5, 6 sequence stamped into the heat sink, loosen the six captive Philllipsscrews (1) and (2) that secure the heat sink to the system board.
 2. Remove the heat sink (3).
 NOTE: Due to the adhesive quality of the thermal material located between the heat sink andthe system board components, it may be necessary to move the heat sink from side to side todetach it.
 NOTE: Steps 3 and 4 apply to computer models equipped with a graphics subsystem with UMAmemory. See steps 1 and 2 for heat sink removal information for computer models equipped witha graphics subsystem with discrete memory.
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3. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllipsscrews (1) that secure the heat sink to the system board.
 4. Remove the heat sink (2).
 NOTE: Due to the adhesive quality of the thermal material located between the heat sink andthe system board components, it may be necessary to move the heat sink from side to side todetach it.
 NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink andthe system board components each time the heat sink is removed. Replacement thermal material isincluded with the heat sink, processor, and system board spare part kits.
 The following illustration shows the replacement thermal material locations on a computer modelequipped with a graphics subsystem with discrete memory.
 ● Thermal paste is used on the processor (1) and the heat sink section (2) that services it
 ● A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) thatservices it
 Component replacement procedures 101

Page 110
                        

The following illustration shows the replacement thermal material locations on a computer modelequipped with a graphics subsystem with UMA memory. Thermal paste is used on the processor(1) and the heat sink section (2) that services it.
 Reverse this procedure to install the heat sink.
 Processor
 NOTE: The processor spare part kit includes replacement thermal material.
 Description Spare part number
 For use only on HP ProBook 6475b Notebook PC computer models:
 AMD A10-4600M 3.20-GHz/2.30-GHz processor with Radeon HD 7660G graphics (4.0-MB L2cache, 1600-MHz DDR3, quad core, 35 W)
 683046-001
 AMD A8-4500M 2.80-GHz/1.90-GHz processor with Radeon HD 7640G graphics (4.0-MB L2cache, 1600-MHz DDR3, quad core, 35 W)
 683048-001
 AMD A6-4400M 3.20-GHz/2.70-GHz processor with Radeon HD 7520G graphics (1.0-MB L2cache, 1600-MHz DDR3, dual core, 35 W)
 683047-001
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Description Spare part number
 AMD A4-4300M 3.00-GHz/2.50-GHz processor with Radeon HD 7420G graphics (1.0-MB L2cache, 1600-MHz DDR3, dual core, 35 W)
 685990-001
 For use only on HP ProBook 6470b Notebook PC computer models:
 Intel Quad Core i7-3820QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB,8.0-MB L3 cache, 45 W)
 681284-001
 Intel Quad Core i7-3720QM 2.60-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB,6.0-MB L3 cache, 45 W)
 681283-001
 Intel Quad Core i7-3610QM 2.30-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB,6.0-MB L3 cache, 45 W)
 680646-001
 Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0-MB L3 cache, 35 W)
 681954-001
 Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W)
 681953-001
 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W)
 681952-001
 Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W)
 680645-001
 Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001
 Intel Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 677152-001
 Intel Celeron B840 1.90-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, 35 W) 664663-001
 Before removing the processor, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Hard drive (see Hard drive on page 62)
 c. Optical drive (see Hard drive on page 62)
 d. WLAN module (see WLAN module on page 70)
 e. WWAN module (see WWAN module on page 68)
 f. Fan (see Fan on page 75)
 g. Keyboard (see Keyboard on page 76)
 h. Base enclosure (see Base enclosure on page 80)
 Component replacement procedures 103

Page 112
                        

i. System board (see System board on page 95)
 j. Heat sink (see Heat sink on page 99)
 Remove the processor:
 1. Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turncounterclockwise, until you hear a click.
 2. Lift the processor (2) straight up, and remove it.
 NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)embossed on the processor socket when you install the processor.
 Reverse this procedure to install the processor.
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USB board
 Description Spare part number
 USB board 658141-001
 Before removing the USB board, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Optical drive (see Optical drive on page 58)
 c. Hard drive (see Hard drive on page 62)
 d. Modem module (see Modem module on page 73)
 e. Keyboard (see Keyboard on page 76)
 f. Base enclosure (see Base enclosure on page 80)
 g. System board (see System board on page 95)
 Remove the USB board:
 1. Release the clip (1) built into the top cover that secures the left side of the USB board.
 2. Lift the left side of the USB board (2) to disconnect the USB board from the system board.
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3. Remove the USB board (3).
 Reverse this procedure to install the USB board.
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Display assembly
 NOTE: The display assembly is spared at the subcomponent level only. For more display assemblyspare part information, see the individual removal subsections.
 Before removing the display assembly, follow these steps:
 1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn thecomputer on, and then shut it down through the operating system.
 2. Disconnect the power from the computer by unplugging the power cord from the computer.
 3. Disconnect all external devices from the computer.
 4. Remove the battery (see Battery on page 55), and then remove the following components:
 a. Service cover (see Service cover on page 57)
 b. Hard drive (see Hard drive on page 62)
 c. Optical drive (see Hard drive on page 62)
 d. WLAN module (see WLAN module on page 70)
 e. WWAN module (see WWAN module on page 68)
 f. Fan (see Fan on page 75)
 g. Keyboard (see Keyboard on page 76)
 h. Base enclosure (see Base enclosure on page 80)
 i. Function board (see Function board on page 93)
 j. System board (see System board on page 95)
 Remove the display assembly:
 1. Position the computer with the front toward you.
 2. Remove the four Phillips PM2.5×7.0 screws (1) that secure the display assembly to the computer.
 3. Swing the display hinges (2) up and back until the top cover is free for removal.
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4. Remove the top cover (3) from the display assembly.
 5. If it is necessary to replace the display bezel or any of the display assembly subcomponents:
 a. Remove the rubber screw covers (1). The rubber screw covers are available in the DisplayRubber Kit, spare part number 642785-001.
 b. Remove the two Phillips PM2.5×5.0 screws (2) that secure the display bezel to thedisplay assembly.
 c. Flex the inside edges of the bottom edge (1), the left and right sides (2), and thetop edge (3) of the display bezel until the bezel disengages from the display enclosure.
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d. Remove the display bezel (4).
 The display bezel is available using spare part numbers 683781-001 (for use only on HPProBook 6475b Notebook PC computer models computer models) and 685999-001 (for useonly on HP ProBook 6470b Notebook PC computer models computer models).
 6. If it is necessary to replace the webcam/microphone module:
 CAUTION: Handle the webcam/microphone module with caution. The module has a thinprofile and is susceptible to damage when not handled carefully.
 a. Detach the webcam/microphone module (1) from the display enclosure. (The webcam/microphone module is attached to the display enclosure with double-sided tape.)
 b. Disconnect the webcam/microphone module cable (2) from the webcam/microphone module.
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c. Remove the webcam/microphone module (3).
 The webcam/microphone module is available using spare part number 684346-001. Themicrophone module is available using spare part number 684346-001.
 7. If it is necessary to replace the display panel:
 a. Remove the eight Phillips PM2.5×4.0 screws (1) that secure the display panel to thedisplay enclosure.
 b. Lift the top edge of the display panel (2) until the display panel rests at an angle.
 c. Remove the display panel (3).
 The display panel is available using the following spare part numbers.
 ● 686047-001 — 14.0-in, LED, FLT, HD+, AntiGlare display panel for use on allcomputer models
 ● 686046-001 — 14.0-in, LED, FLT, HD, AntiGlare display panel for use on all computermodels
 ● 684348-001 — 14.0-in, LED, SVA, HD+, AntiGlare display panel for use only on HPProBook 6470b Notebook PC computer models
 ● 684347-001 — 14.0-in, LED, SVA, HD, AntiGlare display panel for use only on HPProBook 6470b Notebook PC computer models
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8. If it is necessary to replace the display hinge covers:
 a. Remove the two Phillips PM2.5×3.0 screws (1) that secure the display hinge covers to thedisplay hinges.
 b. Slide the display hinge covers (2) toward each other to remove them from the display hinges.
 The display hinge covers are available using spare part number 642783-001.
 9. If it is necessary to replace the display hinges:
 a. Remove the four Phillips PM2.5×3.0 screws (1) that secure the display hinges to thedisplay enclosure.
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b. Remove the display hinges (2) from the display panel.
 The display hinges are available using spare part number 641836-001.
 10. If it is necessary to replace the display panel cable:
 CAUTION: Before turning the display panel upside down, make sure the work surface is clearof tools, screws, and any other foreign objects. Failure to follow this caution can result in damageto the display panel.
 a. Turn the display panel upside down, with the display panel cable toward you.
 b. Release the adhesive support strip (1) that secures the display panel cable to the displaypanel.
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c. Disconnect the display panel cable (2) from the display panel.
 d. Remove the display panel cable.
 The display panel cable is available using spare part numbers 693064-001 (for use only oncomputer models equipped with an HD+ display assembly) and 693063-001 (for use onlyon computer models equipped with an HD display assembly).
 11. If it is necessary to replace the WLAN antenna cables and transceivers:
 a. Release the WLAN antenna cables from the clips (1) and routing channel built into thedisplay enclosure.
 b. Detach the WLAN antenna transceivers (2) from the display enclosure. (The WLAN antennatransceivers are attached to the display enclosure with double-sided tape.)
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c. Remove the WLAN antenna cables and transceivers (3). The WLAN antenna cables andtransceivers are included in the Antenna Kit, spare part number 642799-001.
 12. If it is necessary to replace the WWAN antenna cables and transceivers:
 a. Release the WWAN antenna cables from the clips (1) and routing channel built into thedisplay enclosure.
 b. Detach the WWAN antenna transceivers (2) from the display enclosure. (The WWANantenna transceivers are attached to the display enclosure with double-sided tape.)
 c. Remove the WWAN antenna cables and transceivers (3). The WWAN antenna cables andtransceivers are included in the Antenna Kit, spare part number 642801-001.
 Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) andAdvanced System Diagnostics
 Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the inputand output devices on the system (such as disk drives, display, keyboard, mouse, and printer).Computer Setup includes settings for the types of peripherals installed, the startup sequence of thecomputer, and the amount of system and extended memory.
 NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computerfrom operating properly.
 Starting Computer SetupNOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setuponly if USB legacy support is enabled.
 To start Computer Setup, follow these steps:
 1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”message is displayed at the bottom of the screen.
 2. Press f10 to enter Computer Setup.
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Using Computer Setup
 Navigating and selecting in Computer Setup
 To navigate and select in Computer Setup, follow these steps:
 1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”message is displayed at the bottom of the screen.
 ● To select a menu or a menu item, use the tab key and the keyboard arrow keys and thenpress enter, or use a pointing device to click the item.
 ● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of thescreen, or use the up arrow key or the down arrow key.
 ● To close open dialog boxes and return to the main Computer Setup screen, press esc, andthen follow the on-screen instructions.
 NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) orthe keyboard to navigate and make selections in Computer Setup.
 2. Press f10 to enter Computer Setup.
 To exit Computer Setup menus, choose one of the following methods:
 ● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-leftcorner of the screen, and then follow the on-screen instructions.
 – or –
 Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and thenpress enter.
 – or –
 ● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left cornerof the screen, and then follow the on-screen instructions.
 – or –
 Use the tab key and the arrow keys to select File > Save Changes and Exit, and thenpress enter.
 Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup
 NOTE: Restoring defaults will not change the hard drive mode.
 To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
 1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”message is displayed at the bottom of the screen.
 2. Press f10 to enter Computer Setup.
 3. Use a pointing device or the arrow keys to select File > Restore Defaults.
 4. Follow the on-screen instructions.
 5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and thenfollow the on-screen instructions.
 – or –
 Use the arrow keys to select File > Save Changes and Exit, and then press enter.
 Your changes go into effect when the computer restarts.
 NOTE: Your password settings and security settings are not changed when you restore thefactory settings.
 Updating the BIOSUpdated versions of the BIOS may be available on the HP Web site.
 Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.
 Some download packages contain a file named Readme.txt, which contains information regardinginstalling and troubleshooting the file.
 Determining the BIOS version
 To determine whether available BIOS updates contain later BIOS versions than those currently installedon the computer, you need to know the version of the system BIOS currently installed.
 BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
 1. Start Computer Setup.
 2. Use a pointing device or the arrow keys to select File > System Information.
 3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner ofthe screen, and then follow the on-screen instructions.
 – or –
 Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and thenpress enter.
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NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressingthe esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of thescreen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.
 Downloading a BIOS update
 CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,download and install a BIOS update only when the computer is connected to reliable external powerusing the AC adapter. Do not download or install a BIOS update while the computer is running onbattery power, docked in an optional docking device, or connected to an optional power source.During the download and installation, follow these instructions:
 Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
 Do not shut down the computer or initiate Suspend or Hibernation.
 Do not insert, remove, connect, or disconnect any device, cable, or cord.
 1. Open your Web browser. For U.S. support, go to http://www.hp.com/go/contactHP.For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.
 2. Follow the on-screen instructions to identify your computer and access the BIOS update you wantto download.
 3. Click the option for software and driver downloads, type your computer model number in theproduct box, and then press enter. Follow the on-screen instructions to identify your computer andaccess the BIOS update you want to download.
 4. Click your specific product from the models listed.
 5. Click the appropriate operating system.
 6. Go to the BIOS section and download the BIOS software package.
 7. Follow the installation instructions as provided with the downloaded BIOS software package.
 NOTE: After a message on the screen reports a successful installation, you can delete thedownloaded file from your hard drive.
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Using Advanced System DiagnosticsAdvanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardwareis functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:
 ● Start-up test—This test analyzes the main computer components that are required to startthe computer.
 ● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-uptest does not detect.
 ● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks alldata in every sector of the hard drive. If the test detects a damaged sector, it attempts to move thedata to a good sector.
 ● Memory test—This test analyzes the physical condition of the memory modules. If it reports anerror, replace the memory modules immediately.
 ● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.If the battery fails the test, contact support to report the issue and purchase a replacement battery.
 ● System Tune-Up—This group of additional tests checks your computer to make sure that the maincomponents are functioning correctly. System Tune-Up runs longer and more comprehensive testson memory modules, hard drive SMART attributes, the hard drive surface, the battery (and batterycalibration), video memory, and the WLAN module status.
 You can view system information and error logs in the Advanced System Diagnostics window.
 To start Advanced System Diagnostics:
 1. 1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message isdisplayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,press f2.
 2. Click the diagnostic test you want to run, and then follow the on-screen instructions.
 NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications
 Computer specifications
 Metric U.S.
 Dimensions
 Width 33.80 cm 13.31 in
 Depth 23.13 cm 9.11 in
 Height (front to back) 3.40 to 3.60 cm 1.34 to 1.42 in
 Weight
 Equipped with 9-cell battery, optical drive, graphicssubsystem with UMA memory, one memory module,WLAN module, solid-state drive, and TouchPad
 2.47 kg 5.45 lbs
 Equipped with 9-cell battery, graphics subsystem withUMA memory, one memory module, WLAN module,solid-state drive, and TouchPad
 2.33 kg 5.14 lbs
 Equipped with 6-cell battery, optical drive, graphicssubsystem with UMA memory, one memory module,WLAN module, solid-state drive, and TouchPad
 2.31 kg 5.09 lbs
 Equipped with 6-cell battery, graphics subsystem withUMA memory, one memory module, WLAN module,solid-state drive, and TouchPad
 2.17 kg 4.78 lbs
 Equipped with 6-cell battery, optical drive, graphicssubsystem with UMA memory, one memory module,WLAN module, solid-state drive, and TouchPad
 2.17 kg 4.78 lbs
 Equipped with 6-cell battery, graphics subsystem withUMA memory, one memory module, WLAN module,solid-state drive, and TouchPad
 2.03 kg 4.48 lbs
 Input power
 Operating voltage and current 18.5 V dc @ 3.5 A - 65 W
 – or –
 19.0 V dc @ 4.74 A - 90 W
 Temperature
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Metric U.S.
 Operating 5°C to 35°C 41°F to 95°F
 Nonoperating -20°C to 60°C -4°F to 140°F
 Relative humidity (noncondensing)
 Operating 10% to 90%
 Nonoperating 5% to 95%
 Maximum altitude (unpressurized)
 Operating -15 m to 3,048 m -50 ft to 10,000 ft
 Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft
 NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within thisrange of temperatures.
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14.0-inch SGA display specifications
 Metric U.S.
 Dimensions
 Height 17.6 cm 6.93 in
 Width 31.2 cm 12.28 in
 Diagonal 35.7 cm 14.06 in
 Number of colors up to 16.8 million
 Contrast ratio 200:1 (typical)
 Brightness 200 nits (typical)
 Pixel resolution
 Pitch 0.197 × 0.197 mm
 Format HD+, SVA (1600 x 1900)
 HD, SVA (1366 x 768)
 Configuration RGB vertical stripe
 Backlight LED
 Character display 80 × 25
 Total power consumption 3.46 W
 Viewing angle ±65° horizontal, ±50° vertical (typical)
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Hard drive specifications
 750-GB* 500-GB* 320-GB*
 Dimensions
 Height 9.5 mm 9.5 mm 9.5 mm
 Length 100.2 mm 100.4 mm 100.4 mm
 Width 69.9 mm 69.9 mm 69.9 mm
 Weight 110 g 110 g 110 g
 Interface type SATA SATA SATA
 Transfer rate
 Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec
 Security ATA security ATA security ATA security
 Seek times (typical read, including setting)
 Single track 2.0 ms 1.5 ms 1.5 ms
 Average (read/write) 12/16 ms 11/13 ms 11/13 ms
 Maximum 22 ms 22 ms 22 ms
 Logical blocks 1,465,149,168 976,773,168 628,142,448
 Disk rotational speed 7200 rpm 7200 rpm 7200 rpm
 Operating temperature 0°C to 60°C (32°F to 140°F)
 *1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.
 NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery
 Recovery after a system failure is as good as your most recent backup. As you add new software anddata files, you should continue to back up your system on a regular basis to maintain a reasonablycurrent backup.
 124 Chapter 7 Backup and recovery

Page 133
                        

Performing a recoveryRecovery allows you to repair or restore the computer to its original factory state. You can create an HPfactory image restore DVD, using an installed or an external DVD±RW optical drive. You can alsorestore the computer to its factory condition from the HP dedicated recovery partition on the hard drive.
 CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. Allfiles you have created and any software installed on the computer are permanently removed. Therecovery tool reinstalls the original operating system and HP programs and drivers that were installed atthe factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personalfiles must be restored from a backup.
 To restore the computer using the HP factory image restore DVD, you must first create the recovery disc.To create the recovery disc:
 NOTE: HP recommends that you create the HP factory image restore DVD in the event of asystem failure.
 1. Select Computer > More Applications.
 2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in theright pane.
 3. Follow the on-screen instructions to create an image file to burn a recovery disc.
 To restore the computer from the partition, follow these steps:
 1. If possible, back up all personal files.
 2. Insert the HP Factory Image Restore DVD into the external optical drive and restart the computer.
 3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.
 4. Select the Notebook Upgrade Bay option.
 5. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux bootmenu, and then press enter.
 6. Using the arrow keys, select Yes when prompted: Do you want to start the System-Restore?
 7. Follow the on-screen instructions.
 NOTE: You can also restore the computer from the partition by restarting the computer, and thenpressing the f11 key.
 NOTE: If you are unable to boot (start up) your computer from the hard drive partition with theprimary operating system or from the recovery partition, and you did not create a system recovery disc,you must purchase a SUSE Linux Enterprise Desktop Operating System DVD to reinstall the operatingsystem. For additional information, see the Worldwide Telephone Numbers booklet.
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Backing up your informationYou should back up your computer files on a regular schedule to maintain a current backup. You canmanually back up your information to an optional external drive, a network drive, or discs. Back upyour system at the following times:
 ● At regularly scheduled times
 ● Before the computer is repaired or restored
 ● Before you add or modify hardware or software
 To back up your home directory files using Backup Manager Settings:
 1. Select Computer > More Applications > Tools > Backup Manager Settings, and thenclick the Backup my home directory button.
 2. Click Storage Destination Location, and then select a location to back up your information.
 3. Click Schedule, and then select a time schedule to perform backups at a regularlyscheduled time.
 To immediately back up your information, click the Backup Now check box.
 NOTE: Before you back up your information, be sure you have designated a location to savethe backup files.
 4. Click the Save and Backup button to start the backup and to save the backup settings.
 To restore backup files:
 1. Select Computer > More Applications > Tools > Backup Manager Restore.
 2. Click Backup Source, and then select the location of the backup files.
 3. Click Restore Destination, and then select the destination to restore the files.
 4. To restore all files from the selected location, click the Restore all files button. To restoreselective files only, click the Restore selected files button, and then click the Select Filesbutton and select the files to be restored.
 5. Under Restore Point, click the time and date of the backup.
 NOTE: If multiple backups have been performed, click the Use the latest version button torestore the latest version.
 6. Click the Restore button to start restoring the files, or click the Cancel button to cancelthe operation.
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8 Power cord set requirements
 The wide-range input feature of the computer permits it to operate from any line voltage from 100 to120 volts AC, or from 220 to 240 volts AC.
 The 3-conductor power cord set included with the computer meets the requirements for use in thecountry or region where the equipment is purchased.
 Power cord sets for use in other countries and regions must meet the requirements of the country orregion where the computer is used.
 Requirements for all countriesThe following requirements are applicable to all countries and regions:
 ● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).
 ● All power cord sets must be approved by an acceptable accredited agency responsible forevaluation in the country or region where the power cord set will be used.
 ● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltagerating of 125 or 250 V AC, as required by the power system of each country or region.
 ● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
 Country/region Accredited agency Applicable note number
 Australia EANSW 1
 Austria OVE 1
 Belgium CEBC 1
 Canada CSA 2
 Denmark DEMKO 1
 Finland FIMKO 1
 France UTE 1
 Germany VDE 1
 Italy IMQ 1
 Japan METI 3
 The Netherlands KEMA 1
 Norway NEMKO 1
 The People's Republic of China COC 5
 South Korea EK 4
 Sweden SEMKO 1
 Switzerland SEV 1
 Taiwan BSMI 4
 The United Kingdom BSI 1
 The United States UL 2
 1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance couplerand wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where itwill be used.
 2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-polegrounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.
 3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with theJapanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plugmust be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.
 4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance couplerand wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where itwill be used.
 5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance couplerand wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where itwill be used.
 128 Chapter 8 Power cord set requirements
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9 Recycling
 When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not disposeof the battery in general household waste. Follow the local laws and regulations in your area forbattery disposal.
 HP encourages customers to recycle used electronic hardware, HP original print cartridges, andrechargeable batteries. For more information about recycling programs, see the HP Web site athttp://www.hp.com/recycle.
 129
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